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About This Guide

The User Guide provides information on using basic features of the Operations Center console. It
provides an overview of the different views available in the Operations Center console and the
various types of data accessible from them.

¢ Chapter 1, “Accessing the Operations Center Console,” on page 9

¢ Chapter 2, “Understanding the Operations Center Console,” on page 13

¢ Chapter 3, “Customizing the Console Views,” on page 29

¢ Chapter 4, “Monitoring Elements and Element State,” on page 43

¢ Chapter 5, “Using Find to Search for Elements,” on page 61

¢ Chapter 6, “Filtering and Managing Alarms,” on page 67

¢ Chapter 7, “Charting Performance Data,” on page 97

¢ Appendix A, “Main Menu Options,” on page 117

¢ Appendix B, “Element and Alarm Options,” on page 123

¢ Appendix C, “Documentation Updates,” on page 133

Audience

This guide is intended for all Operations Center console users, especially those users without
Administrator privileges.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the
online documentation.

Additional Documentation & Documentation Updates

This guide is part of the Operations Center documentation set. For the most recent version of the User
Guide and a complete list of publications supporting Operations Center, visit our Online
Documentation Web Site at Operations Center 5.0 online documentation.

The Operations Center documentation set is also available as PDF files on the installation CD or ISO;
and is delivered as part of the online help accessible from multiple locations in Operations Center
depending on the product component.

Additional Resources

We encourage you to use the following additional resources on the Web:

¢ NetlQ User Community (https://www.netiq.com/communities/): A Web-based community with
a variety of discussion topics.

About This Guide 7
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¢ NetlQ Support Knowledgebase (https://www.netiq.com/support/kb/
product.php?id=SG_XOPERATIONSCENTER _1_2): A collection of in-depth technical articles.

¢ NetlQ Support Forums (https://forums.netiq.com/forumdisplay.php?26-Operations-Center): A
Web location where product users can discuss NetIlQ product functionality and advice with
other product users.

Technical Support

You can learn more about the policies and procedures of NetlQ Technical Support by accessing its
Technical Support Guide (https://www.netiq.com/Support/
process.asp#_Maintenance_Programs_and).

Use these resources for support specific to Operations Center:

¢ Telephone in Canada and the United States: 1-800-858-4000
¢ Telephone outside the United States: 1-801-861-4000
¢ E-mail: support@netiq.com (support@netiq.com)

¢ Submit a Service Request: http://support.novell.com/contact/ (http://support.novell.com/contact/

)

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and
items in a cross-reference path. The > symbol is also used to connect consecutive links in an element
tree structure where you can either click a plus symbol (+) or double-click the elements to expand
them.

When a single pathname can be written with a bslash for some platforms or a forward slash for other
platforms, the pathname is presented with a forward slash to preserve case considerations in the
UNIX* or Linux* operating systems.

A trademark symbol (®, ™, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party
trademark.

Operations Center 5.0 User Guide
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Accessing the Operations Center
Console

The Operations Center console acts as a business service control center for exploring, navigating, and
managing various business-related elements and views. The following sections explain the different
ways to log in to and out of the Operations Center console:

¢ Section 1.1, “Logging In,” on page 9
¢ Section 1.2, “Troubleshooting Java Web Start,” on page 11
¢ Section 1.3, “Logging Out,” on page 11

Logging In
Operations Center software is a Web-based application that provides a console as the user interface.

The requirements for logging in to the Operations Center console:

+ A valid user name obtained from the administrator

¢ The Operations Center server, which is the workstation that stores the Operations Center
application, must be up and running

You can access Operations Center through:

¢ The Web using Java Web Start

+ A command line for remote access
To log in to Operations Center, select the applicable method:

¢ Section 1.1.1, “Logging In through the Web,” on page 9

¢ Section 1.1.2, “Starting from a Command Line,” on page 11

Logging In through the Web

Operations Center uses Java Web Start technology to allow users to access the Operations Center
console via the Web. Java Web Start is an application-deployment technology that enables users to
download and launch applications from the Web without having to first complete a separate
installation procedure.

Launch the Operations Center application by navigating in your Web browser to the Operations

Center URL (or link) provided by your Operations Center Administrator. If the application does not
exist on the computer, Java Web Start automatically downloads all necessary files. It then caches the
files on the computer. Re-launch the application at any time, using a desktop icon or a browser link.

Each time you access Operations Center, Java Web Starts automatically updates the application, thus
always loading the most recent version.

Accessing the Operations Center Console
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For additional information, refer to the Oracle Java Web Start Web site.
To access the Operations Center via the Web:

1 Start a Java-enabled Web browser.
2 In the Location/Address field, enter the following Uniform Resource Locator (URL) address:
http://server_name:80

where server_name is the Transmission Control Protocol/Internet Protocol (TCP/IP) host name of
the server that is running Operations Center and 80 is the default port setting on Windows. On
UNIX, the default server port is 8080.

Your administrator might provide a different URL depending on port settings or additional
parameters. For more information about browser defaults, console configuration, and URL
parameters, see the Operations Center 5.0 Server Installation Guide.

The Operations Center server login page displays:

@ documentation

Novell.

3 Click the Login button to open the Login dialog box:

Movell® Operations Center Lagin @

Usemame

Cancel Login »

Connection to server (testdemao) established.

4 Specify the Username and Password.

Both the user name and password are case-sensitive. If necessary, verify the case and spelling
created by the administrator.

10 Operations Center 5.0 User Guide
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1.1.2

1.2

1.3

5 Confirm login to the appropriate server by checking the server name displayed at the top of the
Login dialog box.

6 Click OK to open the Operations Center console.

Starting from a Command Line

Remote users can start Operations Center from the command line. However, a prerequisite is
installing the console with the Java Web Start technology.

To log in remotely:
1 enter the following line at the command prompt:

start http://server_name/client

where server_name is the name of the server where Operations Center is installed and running.

Troubleshooting Java Web Start

If problems occur when accessing Operations Center using Java Web Start, try clearing the cache.

For instructions, see Java’s Web page on clearing the Java cache (http://www.java.com/en/download/
help/plugin_cache.xml)

Logging Out
To log out of the Operations Center console:

1 Do one of the following;:
¢ From the File menu, select Logoff to log out of Operations Center without exiting.
¢ From the File menu, select Logoff and Exit to log out and exit Operations Center.
2 Click Yes to log out.

The Operations Center console closes. The Login dialog displays if not exiting Operations
Center.

Accessing the Operations Center Console 11
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Understanding the Operations Center
Console

The Operations Center console acts as a business service control center for exploring, navigating, and
managing various business-related elements and views. It provides a hierarchical tree view of system
objects as well as a type of Service Dashboard consisting of six different views.

Figure 2-1 The Operations Center Console

@ Novell® Operations Center (engdemo) e

Eile Edit Go View Format Element Alarms Window Help

~
[0 NORTH - 29 open alarms: 10 critical 9 major 5 info 5 OK )
View
Severity Element Date/Time v e Description [ Pane
4% Administration Wajor ) resT 831/2011 1:09:21... 29 =
Elements Wajor =] TesT BIF1/2011 10921 28
@ ¢ Adapter: Event Manager Major & TesT 2312011 1.09:21... 27
Explorer __| Major & TesT 80212011 10321 26
Pane Info ol TesT 8/31/2011 1.09:21... 25
- Trouble Tickets Adapter Info &l TesT B31/2011 1:08:21... 24
<], CiscoWorks2000 DFM Info &l TesT 83172011 1092123
% Service Level Agreements Info & TesT 5312011 109:21... 22
@ [p3 Services =
= resT 83172011 1:08:21... 21 3
&) resT 834/2011 1:09:21... 20
& esT 83172011 1:09:21... 19
) resT 83172011 1.09:21... 18
Major & TeST 83172011 1:09:21... 17
Wajor = resT 83172011 1.09:21... 16
Major ) resT 83172011 1:09:21... 15
Wajor = resT 83172011 1:09:21... 14 b
&) resT 832011 1.09:21... 13
& esT 83172011 1:09:21... 12
) resT 83172011 1:0921... 11
& TesT 831/2011 1:09:21... 10
oK = resT 83172011 1.09:21... 9
s (@l vcer 04044 4.0 o =4
1 + W,
C BH Portal | "i° Metwork QRSN “alavout | L« Performance
Last updated 9/6/2011 3:55:32 PM LZQ alarms, no selection |admin logged in to engdemo since 9/6/2011 3:53:08 PM

The console provides an interface for viewing, navigating, and managing network organizations. It
consists of two main panes:

¢ Explorer (left pane): Lists system elements in a hierarchical tree. The Explorer pane functions as
one of the main controllers for the console by allowing you to navigate element hierarchies, view
element information and perform operations.
For details on the Explorer pane, see Section 2.4, “Navigating Element Hierarchies,” on page 25

¢ View (right pane): Depending on the selected view, the console displays various types of
information about the selected element or the element’s children.

For details on the Explorer pane, see Section 2.1, “Console Views,” on page 14 and Section 2.2,
“Navigating Console Views,” on page 24.

The type of information displayed in the View pane varies depending on the selected tab:

¢ Summary: View a listing of first-level child elements with status information including current
condition, alarm totals, and last reported date/time.

Understanding the Operations Center Console 13



Portal: Administrators can perform multiple functions from this view that contains multiple
panels, similar to what is found in the Properties dialog. Actual panels/options vary depending
on the type of element selected.

Network: Use this spider tool to see the relationship of elements and explore the various levels
of your environment.

Alarms: View and manage alarms for the selected element. Client-side and server-side alarm
filters can be created to refine the data seen here.

For instructions on configurations for alarm suppression, server-side alarm filters and other
configurations that affect the display of alarms; see “Customizing Monitored Elements and
Alarms” the Operations Center 5.0 Server Configuration Guide.

Layout: View a hiearchical diagram of the element and its children or view custom drawings as
created by your Administrator. Layout diagrams provide a visual analysis of critical
relationships and conditions across multiple branches of an element hierarchy.

For instructions on creating custom drawings in the Layout View, see the Operations Center 5.0
Custom Drawing and Layout Guide.

Performance: Chart real-time performance information or historical information such as alarm
history to provide an indication of how an element is performing.

For instructions on capturing alarm history and performance metrics, see “Capturing Alarm and
Performance History” the Operations Center 5.0 Server Configuration Guide.

Review the following sections to understand the different views, elements, and how to navigate the
console:

*

*

Section 2.1, “Console Views,” on page 14

Section 2.2, “Navigating Console Views,” on page 24

Section 2.3, “Using Menus and Toolbar Options,” on page 24
Section 2.4, “Navigating Element Hierarchies,” on page 25

Section 2.5, “Root Elements,” on page 26

Section 2.6, “Working with Multiple Console Windows,” on page 27
Section 2.7, “Verifying the Server Name,” on page 28

2.1 Console Views

The console provides a hierarchical tree of network organizations, including six different views that
are accessed through tabs at the bottom of the window: Summary, Portal, Network, Alarms, Layout, and
Performance.

The information displayed depends on the selected view, and is filtered for the element selected in
the Explorer pane. The level of detail displayed depends on the permissions set by the administrator.
For more information on permissions, see the Operations Center 5.0 Security Management Guide.

The following sections contain illustrations of the six different views:

*

*

*

Section 2.1.1, “Summary View,” on page 15
Section 2.1.2, “Network View,” on page 16
Section 2.1.3, “Alarms View,” on page 17
Section 2.1.4, “Layout View,” on page 18
Section 2.1.5, “Portal View,” on page 20

Section 2.1.6, “Performance View,” on page 23

14 Operations Center 5.0 User Guide
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Summary View

The Summary view displays the first-level child elements of the element selected in the Explorer pane.
Use the Summary view to view condition and summary information about the elements in a
heirarchy.

Figure 2-2  Console Summary View
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The bottom status bar displays the total number of elements in the Summary view and the number of
elements currently selected.

For instructions on using the Summary view to manage element status, see Chapter 4, “Monitoring
Elements and Element State,” on page 43.
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2.1.2

Network View

The Network view provides a graphical view of elements and their relationship to other elements
within the larger infrastructure. It presents the selected element at the center of the view, with lines
connected to first-level child elements. The line colors identify the condition of the child element:

Figure 2-3 Network View
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User access privileges determine which elements display in the Network view. The currently selected
level of the element hierarchy in the Explorer pane determines whether the entire network displays,
or only a portion of it.

For instructions on using the Network view to navigate and monitor elements, see Section 4.4,
“Exploring Hierarchies Using the Network View,” on page 51.
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2.1.3 Alarms View

The Alarm View displays information about alarms associated with the elements, allowing you to
gain insight into the state and activity of your technology components and business services.

Figure 2-4 Alarms View
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Create one or more alarm filters to manage and filter alarms.

For instructions on using the Alarms view to manage and filter alarms, see Chapter 6, “Filtering and
Managing Alarms,” on page 67.
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2.14

Layout View

The Layout view allows you to manage and monitor services using a graphical representation that
focuses on the relationships among the elements. Figure 2-5 shows the default bubble layout used by
the Layout view.

Figure 2-5 Layout View
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The Layout view is available for all elements, including:

¢ Services > Locations: Displays a global map. Each color-coded geographical site identifies the
most severe condition among its child elements.

¢ Services > Service Models: Displays icons representing any element and type of relationship
among elements, such as functional organizations or processes. Customize the view using
drawing tools.

Your Administrator can customize the Layout view by creating custom drawings. The type and level
of drawing is only limited by your creativity. For example, Layout views for elements under Services >
Locations show element nodes positioned on a geographical map:

Figure 2-6 Example of a Location Layout View
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For instructions on creating custom drawings in the Layout View, see the Operations Center 5.0 Custom
Drawing and Layout Guide.
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2.15

Portal View

The Portal view provides a comprehensive view and management gateway for each system element.
It also contains sections for links to other views or related elements, element actions, and element
notes. Because options on elements vary depending on the type of element, the number and names of
Portal sections vary among adapters and elements.

The following is a typical view for an adapter under the Elements root:

Figure 2-7 Portal View
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Access to options depends on the user’s access privileges. Some administrative tasks are easiest when
performed in the Portal view. For example:

¢ Defining users and groups

For information on assigning permissions to users and groups, see the Operations Center 5.0
Security Management Guide.
¢ Defining automation events

For information on defining automation events, see “Defining and Managing Automation
Events” in the Operations Center 5.0 Server Configuration Guide.

¢ Setting up calendars and schedules

For information on setting up time management objects, see “Time Categories, Calendars, and
Schedules” in the Operations Center 5.0 Server Configuration Guide.

By default, the Portal view displays with its sections collapsed. Table 2-1 shows the sections
commonly found in the Portal view.
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As you work, the Portal view “remembers” the expanded and collapsed settings for each section.
Therefore, as you click from element to element, only the sections you were working in stay open.
Taking the same actions on more than one element is especially convenient through the Portal view
and saves the time of opening and closing the Property pages for each element.

Table 2-1 describes some of the various options, which vary depending on the type of element

selected.

Table 2-1 Standard Portal View Sections

Name

Description

ACCESS CONTROL

ACTIONS

AUDIT

AUTOMATION

BLACKOUT CALENDAR

COMMENTS
CONDITION

CONTACT

DEFINITION
ELEMENTS

Enables administrators to view and define access privileges for an element.

For information, see “Assigning Privileges to Elements” in the Operations Center 5.0
Security Management Guide.

Performs specific actions on the selected element.
For example: Acknowledge, Manage, Ping, Trace Route, Unmanage.

If you have purchased the SLM and the element has performance data, select the
Analyze action to open a Performance Analysis window.

Enable audit events available for administrative elements.

For information, see “Auditing” in the Operations Center 5.0 Security Management
Guide.

Enables administrators to define a list of automated events and actions for an
element.

For information, see “Defining and Managing Automation Events” in the Operations
Center 5.0 Server Configuration Guide.

Identifies any blackout calendars as defined for the element.

For information, see “Time Categories, Calendars, and Schedules” in the Operations
Center 5.0 Server Configuration Guide.

You can enter comments about the element, and view comment histories.

Enables administrators to specify the algorithm to use to calculate an element’s
condition.

The Condition tab is available for elements created using event-based adapters
only. It is not available for elements created using object-based adapters such as
NetlQ, HP OpenView, the Intercommunication adapter, and Spectrum.

For information, see “Using Algorithms to Calculate Element State” in the Operations
Center 5.0 Server Configuration Guide.

Enables administrators to specify contact information for elements in the Services
hierarchy.

Displays the XML code used to generate the element.

Enables administrators to specify the elements that drive the element’s alarms and
condition. The Elements tab is available for elements under Service Models.

For information on Service Models, see the Operations Center 5.0 Service Modeling
Guide.
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Name Description

IMPACTED Shows all objects that are affected by the element’s state.
For information, see Section 4.6, “Viewing Root Cause and Impacted Elements,” on
page 55.

OBSERVATIONS Displays comments about the element and its descendents.

For example, the number and type of alarms.

PERFORMANCE A list of all available performance profiles showing those where the element is a
member.

Select a profile’s check box to add or remove it from the profile.

The Data Warehouse uses profiles to select the elements for which alarm history is
collected.

For information on creating profiles, see “Capturing Alarm and Performance History
in the Operations Center 5.0 Server Configuration Guide.

PROPERTIES Displays a list of properties for the selected element, including the current condition
level and most recent update time.

Depending on the element type, other properties can be displayed, including the
port number, number of timeouts, heartbeat, reconnected poll, connect mode, filter,
and worst application instance.

For information on adapter properties, see “Adapter Property Reference” in the
Operations Center 5.0 Adapter and Integration Guide.

RELATED Provides links to the parent and descendents of an element using the provided links.
ROOT CAUSE Identifies the objects that affects the selected element’s state.
The Details pane identifies the hierarchy of the elements involved.

For information, see Section 4.6, “Viewing Root Cause and Impacted Elements,” on

page 55.
SERVICE LEVEL Identifies any service level settings or objectives that are defined for the element.
AGREEMENTS ) )
To learn more about Service Level Agreements, see the Operations Center 5.0
Service Level Agreement Guide.
STATUS View basic status information for the element.
VIEWS Provides links to open views (Summary, Network, Layout, and Alarms) using the

provided links.

TIP: Right-click the background of any section in the Portal view (except the view’s gray background)
to display a menu for the selected element.
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2.1.6 Performance View

The Performance view charts system performance in real time, including historical performance data
for elements associated with specific management systems or with the Service Level Manager (SLM),
which is a product of Operations Center for managing service level agreements (SLAs).

Figure 2-8 Performance View
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For information on charting performance data, see Chapter 7, “Charting Performance Data,” on
page 97.

For details on configurations for capturing historical data or default chart settings, see “Capturing
Alarm and Performance History” in the Operations Center 5.0 Server Configuration Guide.

For information on using the Performance view in connection with SLM and SLAs, see the Operations
Center 5.0 Service Level Agreement Guide.
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2.2 Navigating Console Views

The View pane displays details about the element or children of the element selected in the Explorer
pane. There are six view tabs (Summary, Portal, Network, Alarms, Layout, and Performance) along the
bottom of the View pane.

The View title bar displays the name of the element currently selected in the Explorer pane.
Information about the element’s children displays in the View pane. The level of detail displayed
depends on the permissions set by the administrator. For more information on permissions, see the
Operations Center 5.0 Security Management Guide.

To access a view:

1 Click the desired tab at the bottom of the View pane. Table 2-2 list the console views.

Table 2-2 Console Views

. Keyboard .

View Name Shortcut Description

Summary Ctrl+1 Lists the condition of all subelements as well as the last reported date and
time and notes about specific elements.

Portal Ctrl+2 Provides a gateway into different areas that contain information about a
selected element.
Administrators use this view to modify the profile of a group, start or stop
an adapter, and so on, from a single screen.

Network Ctrl+3 Displays a graphical representation of the selected element in relation to
all connected elements in the network.

Alarms Ctrl+4 Displays a list of alarms associated with the selected element.

Layout Ctrl+6 Displays a graphical representation of element relationships.

Performance Ctrl+7 Graphs performance data for specified elements if historical data is

available.

The selected view displays.

2.3 Using Menus and Toolbar Options

Console menu options provide navigating the element hierarchy, console window, and different
views. Other options perform tasks such as finding an element, opening new console windows, and
changing user passwords. Menu options can vary depending on the type of element and view
selected.

The toolbar provides buttons for navigating windows and element hierarchies. The other buttons
allow you to locate specific elements and perform routine tasks. The buttons vary depending on the
selected view. For example, the Alarms view provides additional toolbar buttons for managing alarm
data. The Performance view provides additional buttons to assist with charting performance data.
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2.4

Table 2-3 lists the available buttons.

Table 2-3 Console Toolbar Buttons

Button Description

B Displays the previous view.

Forward Displays the next view.
Used with B to retrace steps during the current session. Invalid when viewing the most recent
view.

Up Navigates up one level in the hierarchy displayed in the Explorer.

Home Displays the top level of the selected element’s branch.

Find Searches for elements based on specified criteria.

Chat Opens a dialog box for communicating with other console users. Note that console users are not
able to chat with dashboard users.

Filter Suppresses the display of alarms or elements based on severity or condition.

Navigating Element Hierarchies

The Explorer pane consists of a hierarchy tree that enables drilling down to detailed levels of the
objects in a managed organization. The selected root element is the top-level of the hierarchy. The

first level beneath the root element consists of the major components defined for the root element.

The second level consists of the children of the first level elements. Subsequent levels display the
child elements of the previous level. For example:

Figure 2-9 Explorer Pane Hierarchy
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A |+l icon displays next to rolled-up elements that have child elements.

Before displaying elements in the Explorer pane, some management systems must discover elements
from the Object Request Broker (ORB), or another program that controls the communication between
a client and an object on a server, such as the Simple Network Management Protocol (SNMP). In such
a situation, discovering.. displays next to an element to indicate the communication protocol is
performing the discovery process. The word retrieving.. displays next to elements being retrieved

in the console. The communication protocol previously discovered these elements, and they reside

on the server.
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24.1

2.4.2

2.5

To expand or collapse an element level:

¢ Section 2.4.1, “Expanding an Element Level,” on page 26

¢ Section 2.4.2, “Collapsing an Element Level,” on page 26

Expanding an Element Level

To expand an element level, do one of the following:
¢ Double-click an element.
¢ Click [# next to the element.

A =t displays next to expanded elements.

In the documentation, we use the verb “expand” instead of “double-click” or “click the[*l icon” and
we sequentially list the elements to be expanded, separated by the > character. For example:

In the Explorer pane, expand the Administration root element > Server.

This means to click the [#| for Administration to expand its children, then click the [+l for Server to
expand its children. Or, you can double-click Administration and Server to get the same effect.

Collapsing an Element Level

To collapse (roll-up) an element level, do one of the following;:
¢ Double-click an element.
¢ Click [=} next to the element.

A [+l displays next to collapsed elements.

In the documentation, we use the verb “collapse” instead of “double-click” or “click the [=}icon”.

Root Elements

The Explorer pane provides a hierarchical view of elements that represent technology resources,
organizational resources, or tasks. The Explorer pane groups all elements under standard root
elements. The ability to view individual root elements and their hierarchies depends on assigned
permissions.

Figure 2-10 Root Element Drop-Down List

Sel oot element:
erprise

m

Change your bookmarks:

Bookmark this element

Operations Center 5.0 User Guide



2.6

Select a new root element by using the root element drop-down list, as shown in Figure 2-10. Add
new root elements by using the Bookmark feature. For instructions on creating bookmarks, see
Section 3.2, “Bookmarking Elements,” on page 31.

To select a root element:
1 Click the arrow next to the current root element and then select a root element from the drop-
down list:
¢ Enterprise: The topmost element that contains all other root elements as its children.

¢ Administration: Intended for administrators to perform administrative and maintenance
tasks.

Only users with administrator permissions can access these elements.

¢ Elements: A detailed hierarchy of system and network components with multiple levels of

elements defined for adapters.
¢ Service Level Agreements: A hierarchy of Service Levels for a service.
Provides a view of objectives and affected elements.
For details on using SLAs, see the Operations Center 5.0 Service Level Agreement Guide.

¢ Services: Groups information into containers defined by the administrator to visualize
related elements, such as a corporate organizational hierarchy or geographical sites.

¢ Locations: A branch of the Services hierarchy. Location elements typically pertain to
geographic sites.

¢ Service Models: A branch of the Services hierarchy. Service Model elements define how

a set of enterprise resources impacts a business function.

For details on creating elements in the Services hierarchy, see the Operations Center 5.0 Service
Modeling Guide.

TIP: The child elements, which are the elements grouped under a root element, display in the
Explorer pane.

Working with Multiple Console Windows

The Operations Center console allows you to open and work from multiple windows. Open a new
window by selecting Window > New Window from the menu bar.

Add new windows and drag them to a new position or resize to create the desired workspace.
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Figure 2-11  Windows can be resized and arranged in the console.
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After maximizing a window, reopen all windows by selecting Window > Tile, or Window > Cascade
from the menu bar.

2.7 Verifying the Server Name

When multiple Operations Center consoles are open, there are a few ways to identify the server
associated with a particular client:

¢ View the title bar of the console window, which displays the server name:

@ Novell® Operations Center (testdemo)

‘EME Edit Go View Format Element Window Help

¢ When you select File > Logoff, the server name displays in the confirmation dialog box title bar.

¢ When running under Microsoft Windows, the server name displays in the Operations Center
taskbar icon.

¢ From the Help menu, select About.
The server name displays in the About dialog box title bar.

¢ If you stop and restart the server, the server name displays in the dialog box that offers the
option to try reconnecting to the server.
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Customizing the Console Views

Customize the console views by minimizing the Explorer pane, changing the condition/severity
colors, changing fonts or setting background colors, and adding element bookmarks. Operations
Center saves these customizations as user settings, so that changes made by one user do not affect
other users.

¢ Section 3.1, “Customizing the Explorer Pane,” on page 29

¢ Section 3.2, “Bookmarking Elements,” on page 31

*

Section 3.3, “Setting the Default View,” on page 33

*

Section 3.4, “Working with Tabular Data,” on page 33

*

Section 3.5, “Customizing View “Look & Feel”,” on page 37

*

Section 3.6, “Managing Condition/Severity Colors,” on page 40

3.1 Customizing the Explorer Pane

It is possible to configure the Explorer pane in various ways. Some configurations are related to the
icon indicators next to the element objects in the hierarchy tree. Other options are related to the size
and state of the Explorer pane.

¢ Section 3.1.1, “Hiding or Displaying Condition Indicators,” on page 29

*

Section 3.1.2, “Displaying Linked Element Indicators,” on page 30

*

Section 3.1.3, “Displaying Nonsource Element Indicators,” on page 30

*

Section 3.1.4, “Changing the Explorer Pane Width,” on page 31

*

Section 3.1.5, “Hiding and Restoring the Explorer Pane,” on page 31

*

Section 3.1.6, “Selecting a Root Element When the Explorer Pane Is Hidden,” on page 31

3.1.1 Hiding or Displaying Condition Indicators

To hide or display the condition indicators in the Explorer pane:
1 In the Explorer pane, right-click the background, then select Show Condition Indicators:

Select root element:

E‘.'_' Enterprise -

=1l 5 Enterprise
I O}& Administration
E| 0. Elements

___0 0 pdapter: BMC ¥ Show condition indicators
ihs|
Adapter BM{ ¥  Show non-source element indicators

MEyEE i '/ Showllnked elementmdlcators
B 0 Adapter: CA ... —

When selected, condition indicators display.
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3.13

Displaying Linked Element Indicators

A linked element icon displayed in the Services hierarchy indicates that the element was created
elsewhere in the hierarchy and later linked to this parent using the Link option.

Figure 3-1 Linked Element Indicator

S &Tu Service Models
—Q Infrastructure Components
. ©-@ = Application Servers
+- o @ = gaintel1
+ o @ B gaintel3

Linked elements contribute to the state of the parent unless the link has been severed. For more
information, see Section 3.1.3, “Displaying Nonsource Element Indicators,” on page 30

To hide or display linked element indicators:

1 In the Explorer pane, right-click the background, then select Show Linked Element Indicators.

When selected, the linked element indicators display next to elements that are linked from
another hierarchy.

Displaying Nonsource Element Indicators

Broken connector lines that display in the Services hierarchy indicate that a child element does not
contribute to the state of its parent. This symbol is known as a nonsource contributing link.

The Link option is used to link a Services element as a child of another Services element. In this case,
the child to contribute to the condition of the new parent. Removing the link allows the child to still
display in that part of the hierarchy, but with its condition no longer affects the parent, as symbolized
by the nonsource element link icon:

Figure 3-2 Nonsource Element Indicator

= B Management System Status

/4@ g3, none
/£ g3, Toronto
-4 £ O g, Utah

4

b £ A3 Virginia
To hide or display nonsource element indicators:
1 In the Explorer pane, right-click the background, then select Show Non-source Element Indicators:

¥ Show condition indicators
v Show nen-source element indicators

v Show linked element indicators

When selected, the non-source element indicators display next to elements.
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3.15

3.1.6

3.2

Changing the Explorer Pane Width

To expand or reduce the width of the Explorer pane:

1 Click the right border of the pane and drag the mouse to the left or right when a horizontal
arrow appears.

Hiding and Restoring the Explorer Pane

¢ “Hiding the Explorer Pane” on page 31
¢ “Restoring the Explorer Pane” on page 31

Hiding the Explorer Pane

To hide the Explorer pane:
1 Click the x in the top right corner of the Explorer pane.

Select root element:

E‘.‘; Enterprise -

=@l Enterprise ~
--O}% Administration
=@ (=]l Elements

The Explorer pane disappears and the View pane maximizes to fill the console. The current the
root element name displays in the View pane title bar, under the toolbar menu.

Restoring the Explorer Pane

To restore the Explorer pane:

1 From the View menu, select Explorer Pane to display the Explorer pane.

Selecting a Root Element When the Explorer Pane Is Hidden

To select a new root element when the Explorer pane is hidden:

1 In the View pane title bar, click the root element name to display the Explorer pane.
2 Click the Root Element drop-down list, then select a different root element.

The title bar and View pane update. The Explorer pane disappears.

Bookmarking Elements

The root element menu is available at the top of the Explorer pane and allows bookmarks to be
created for more custom and easier navigation. It provides a way to access an element, perhaps a
child element that is several levels beneath the root, using a single click. Create bookmarks for
frequently accessed elements.

¢ Section 3.2.1, “Understanding Bookmarking in Operations Center,” on page 32

¢ Section 3.2.2, “Bookmarking the Current Element,” on page 32

¢ Section 3.2.3, “Bookmarking an Element from a List,” on page 33
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¢ Section 3.2.4, “Accessing a Bookmark,” on page 33

¢ Section 3.2.5, “Removing a Bookmark,” on page 33

3.2.1 Understanding Bookmarking in Operations Center

Figure 3-3 shows the Source Data bookmark displayed in the list of root elements:

Figure 3-3 Root Element Drop-Down List

Select root element:
E‘.‘; Enterprise ~

Choose a new root element:

I, Enterprise

%' Locations

-7 Senvice Models

Change your bookmarks:

Bookmark this element

Bookmark element...

Table 3-1 summarizes the Bookmark menu options.

Table 3-1 Bookmark Options

Option Function

Bookmark This Element Adds the current element currently to the root element selection list.

Bookmark Element Opens a dialog box displaying all root element hierarchies to select an element to
bookmark.
Remove Bookmark Deletes the bookmark that is currently selected as the root element.

3.2.2 Bookmarking the Current Element

To bookmark the current element:

1 Select the desired element in the Explorer pane.
2 Click the root element drop-down list, then select Bookmark This Element.

A link to the element displays in the root element drop-down list.
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3.2.3 Bookmarking an Element from a List

To bookmark any element:

1 Click the root element drop-down list, then select Bookmark Element.
A drop-down list displays the hierarchy for each root element.

2 Select an element at any level, then click OK to add it to the root element selection list.

3.24 Accessing a Bookmark

To access a bookmark:

1 Click the root element drop-down list and then select the bookmark.

3.25 Removing a Bookmark

To delete a bookmark:

1 Click the root element drop-down list and then select Remove Bookmark.

3.3 Setting the Default View

The Summary view is the default view. The default view opens immediately after selecting any
element in the Explorer pane.

To change the default view:

1 From the View menu, click Default View, then select a view type:
None: The view type does not change after selecting an element in the Explorer pane.
Auto-Select: Operations Center selects a view that corresponds to the type of selected element.

For example, if the selected element under the Administration root is a folder, such as Adapters or
Automation/Repository, the Summary view is the default view.

Summary: The view changes to Summary.
Portal: The view changes to Portal.
Network: The view changes to Network.

Layout: The view changes to Layout.

The selected view displays immediately after selecting any element in the Explorer pane.

3.4 Working with Tabular Data

You can customize tabular data in the Summary and Alarms views in the following ways:

¢ Sort the elements (Summary view) or alarms (Alarms view) by different columns
¢ Rearrange the order of data columns
+ Hide or show columns

+ Resize columns
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The following sections describe:

¢ Section 3.4.1, “Sorting Data,” on page 34
¢ Section 3.4.2, “Hiding, Displaying, and Selecting Columns,” on page 34

¢ Section 3.4.3, “Sizing Columns,” on page 36

3.4.1 Sorting Data

Some analyses might require sorting elements or alarms in the Summary or Alarms view by a specific
data column. When you sort the display of alarms based on any column other than the common
columns (Severity, Element, Date/Time, ID), sorting is performed using a string sort, so numeric data
values might not sort properly.

To sort elements or alarms by a specific column:

1 In the Summary or Alarms view, click a column heading:

(7 Adapter: BMC Software PATROL(r) - 200 open alarms: 38 critical 81 info 81 OK

Severity Element Date/Time + EID Status Class Host
Network Proto... 12/23/2010 5:21:2... 100782 OPEN Worstapp qaintel3
Network Proto... 12/23/2010 5:21:2... 100781 OPEN UpdinstState qaintel3
TCP 122302010 5:21:2... 100780 OPEN Worstapp qaintel3d
TCP 122302010 5:21:2... 100779 OPEN UpdinstState qaintel3d
A TCPtcpConne... 12/23/2010 5:21:2... 100778 OPEN UpdParState gainteld
B qaintelt 1202302010 5:20:3... 122812 OPEN NTEventReportDet... gaintel
OK COM_APPLIC... 127232010 5:20:3... 100777 OPEN UpdAppState qainteld
0K COM+ 1202302010 5:20:3... 100776 OPEN UpdAppState gaintel

The items in the column sort in descending order, as represented by the down arrow icon.

2 Click the heading a second time to sort in ascending order. The up arrow icon displays in the
column.

3 Rearrange the order in which the columns display by clicking and dragging a column to a new
location.

3.4.2 Hiding, Displaying, and Selecting Columns

+ “Hiding Columns” on page 35
¢ “Displaying a Hidden Column” on page 35
¢ “Selecting Multiple Columns” on page 35
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Hiding Columns

To hide a column:

1 Right-click a column heading.

A drop-down list of available column headings displays:

Severity Element
Info v Severity
v Element
Info v Date/Time
oK D
i: v ED
Info v Status
v Class
oK v Host
OK v Application
- v Instance
v Description
Critical
Info More...

Date/Time =
127252010 11:35

EID
- 134730

12/25/2010 11:35

... 134728

122572010 11:35

.. 134728

1202502010 11:35

... 168050

12252010 11:35

... 168049

122572010 11:35

-... 168048

2252010 11:34:

134727

2252010 11:34:.

134726

122502010 11:34:.

134725

12252010 11:34....

134724

12252010 11:34:.

134723

A12/25/2010 11:34:.

168047

122502010 11:34:.

168046

122502010 11:34:.

168045

A check mark identifies the columns currently displayed. The column names vary among
adapters associated with the alarms.

2 Click More to view additional columns.
3 Click to remove the check mark next to a column name.

The column disappears from the Alarms view.

4 To rearrange the order in which the columns display, click and drag a column to its new location.

Displaying a Hidden Column

To display a column:

1 Right-click a column heading.

A drop-down list of column headings displays.

2 Select a column name.

A check mark displays next to the column and the column displays in the view.

Selecting Multiple Columns

To select multiple columns:

1 Right-click a column heading to display a drop-down list.

2 From the drop-down list, select More to open the Show/Hide Columns dialog box.

3 Do one of the following:

* Select individual check boxes, or click Check All to select all check boxes.

* To deselect all columns at the same time, click Check None.
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4 Click OK.

The selected columns display in the view and the deselected columns disappear from the view:

@ Show / Hide Columns @
Check columng to show f hide:
i
Element
Date/Time :Default Date Format -
Fm
E Chedk Al
EID
Check None
Status
Class
Host N
Application
[ oK ] [ Cancel ]

The Date/Time column has multiple display options. In addition to the standard mm/dd/yy
format, you can specify only a 24-hour clock display without the date, as well as other date/time
display combinations.

5 Click the drop-down to view, then select a date and time format:

@ Show / Hide Columns @
Check columng to show f hide:
Severity ol
Element
Date/Time |Default Date Format. v
o Default Date Format =
M/dfyyyy himm:ss a = Check Al
EID M/dfyyyy hhimmissa =

M/dfyyyy Himm:ss Check None

Status M/dfyyyy HH:mm:ss
M/dfyy himm:ss a
s M/dfyy hh:mm:ss a

Host M/d/yy H:mm:ss

Application

3.4.3 Sizing Columns

The default column size might make it difficult to read values in specific columns. Use the Fit
Columns option to expand specific columns to accommodate the longest text strings that they contain.

To resize columns based on the length of text strings:

1 From the Format menu, select Fit Columns to open its dialog box.

By default, all columns are selected.
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2 Do one of the following:

* Deselect individual column names.

Fit Columns @

Select column(s) to fit:

Severity
Element

Date/Time
EID
Status
Class
-
Application
Instance
Description
[ oK ][ Cancel ]

* Click Select All or Select None to select all or none of the columns at the same time.

3 Click OK to resize each selected column to accommodate the longest text string in it:

Customizing View “Look & Feel”

You can customize the view display in the following ways:

¢ Change the display font (Summary, Network, and Alarms view)
¢ Change the background color of the Network view

¢ Select a specific view as the default
To customize a view display:

¢ Section 3.5.1, “Changing the Display Font (Summary, Network, and Alarms Views),” on page 37
¢ Section 3.5.2, “Hiding or Displaying Text Labels (Network View),” on page 38
¢ Section 3.5.3, “Changing Background Color (Network and Layout Views),” on page 38

Changing the Display Font (Summary, Network, and Alarms Views)

To change the font displayed in the Summary, Network, or Alarms view:

1 In the View pane, select the Summary, Network, or Alarms tab.

2 Click Format, and select one of the following;:
¢ Enlarge Font: Displays the font in the next largest size. Applies to Network view only.
¢ Shrink Font: Displays the font in the next smallest size. Applies to Network view only.

¢ Set Font: to change the font type, style or size.
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3.5.2

3.5.3

The Select Font dialog box opens:

Select Font &
Name: Style: Size:
Do s
San.sSerlf Bolt?l 9 Default
Serif Italic 10
Monospaced Bold Italic
DialogInput 12
13
14
15
18
24
32
45
a0
Sample
AaBbCc12345

Select the font’s name, style, and size.

(Optional) To return to the system default 12 point Dialog font, click Default.
Click OK.

The selected font displays in the view.

Hiding or Displaying Text Labels (Network View)

To change the font displayed in the Network view:

1 Select Display Text in the Format menu.

When selected, the text labels display. When deselected, all text representing each element
disappears and only icons representing the different kinds of elements display.

Changing Background Color (Network and Layout Views)

It is possible to change the background color of the Network and Layout views.
To change the background color:

1 In the View pane, select the Network or Layout tab.

2 Click Format, then select Choose Background Color to open the Choose Background Color dialog
box.

TIP: This option is also available from the right-click menu on the view background.
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3 In the Choose Background Color dialog box, click a tab to open the color selector:

¢ In the Swatches tab, point, then select a new background color:

@ Choose Background Color ﬁ

‘Swatches || 4sp | res

Recent:

Preview

n - . Sample Text Sample Text
. . . Sample Text Sample Text

[ OK H Cancel H Reset ]

* In the HSB tab, select a hue and saturation.

Use the scroll bar to select a hue.

Click the color in the palette. The selected color appears in the Preview section.
¢ In the RGB tab, create a new color by specifying red, green, and blue values.

Move the Red, Green, and Blue sliders to adjust the RGB values. The selected color appears in
the Preview dialog box:

@ Choose Background Color ﬁ

Swatches | HsE | RGE

Red U 95+
a 85 170 255

Green G 160
a 85 170 255

Blue U 2365
a 85 170 255

Preview

[ OK H Cancel H Reset ]

4 Click OK.

The new background color displays in the Network view.
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3.6

3.6.1

Managing Condition/Severity Colors

Filtering features in the Operations Center console can hide some elements and their information
from a view. You can use the filtering feature in the Summary, Network, Alarms, and Layout views. The
condition/severity filter buttons (located on the toolbar) select events using color codes that represent
degrees of criticality. The colored buttons display from left to right in order of most critical to least
critical. In general, condition refers to elements and severity refers to alarms:

Figure 3-4 Condition/Severity Filter Buttons

Fiter: [F]o [0 [ o [F]o o [F]o Flo

Table 3-2 describes the standard condition/severity color codes and their default definitions from
most critical to least critical.

Table 3-2  Default Color Codes

Color Description

Red CRITICAL
Orange MAJOR

Yellow MINOR

Blue INFORMATIONAL
Green OK

Gray UNKNOWN
Brown UNMANAGED

The color codes help prioritize alarms and events to sort or filter based on condition or severity. For
example, sort elements from most critical to least critical, or filter out elements having an OK or
INFORMATIONAL condition, to focus on problem areas.

The following sections explain how to modify color themes:

¢ Section 3.6.1, “Selecting a New Color Theme,” on page 40
¢ Section 3.6.2, “Modifying Colors in a Scheme,” on page 41

¢ Section 3.6.3, “Creating a Custom Color Scheme,” on page 42

Selecting a New Color Theme

To select a color from the six default color themes:
1 From the Format menu, select Condition/Severity Colors to open the Condition/Severity Color
Settings dialog box.
2 Click the Choose a Supplied Color Theme drop-down list, then select a color theme.
3 Select the Change System Settings check box to set the theme as the default for all users.
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4 Click OK.

The condition/severity codes display using the selected color theme:

r b |
Condition/Severity Color Settings I&J

Choose a supplied color-theme:

Light -

Condition/severity:

Backaground Color

{custom)

Foreground Caolor

(custom)

Busy | |

[] change system settings [ 0K l [ Cancel ]

3.6.2 Modifying Colors in a Scheme

To modify one or more colors in a color scheme:

1 From the Format menu, select Condition/Severity Colors to open the Condition/Severity Color
Settings dialog box.

2 In the Condition/Severity section, select a condition color to change. The Background and
Foreground Color drop-down lists activate.

3 Click the Background and Foreground Color drop-down lists, then select new colors.
4 Select the Change System Settings check box to change the theme for all users.
5 Click OK.

The selected condition/severity code displays using the new color.
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3.6.3 Creating a Custom Color Scheme

It is possible to customize the colors that represent condition/severity levels. There are six default
color themes.

To create an additional color theme using the color selector:

1 From the Format menu, select Condition/Severity Colors to open the Condition/Severity Color
Settings dialog box.

2 Click the Choose a Supplied Color Theme drop-down list, then select (Customized).

Conditicn/Severity Color Settings @

Choose a supplied color-theme:
Light -
(customized)

System Defaults

Classic I Background Color

150 (custom)
150 "Light™
Barney

OK

Foreground Color
Idle P
At (custom)

Busy [ |

[7] change system settings [ oK ] [ Cancel ]

3 Select a color condition to change.
This activates the Background and Foreground Color drop-down lists.
4 Click the Background and Foreground Color drop-down lists, then select new colors.

5 Continue selecting condition/severity codes and changing their background and foreground
colors.

6 Select the Change System Settings check box to add the theme for all users.
7 Click OK to apply the new color theme.

42 Operations Center 5.0 User Guide



4.1

411

Monitoring Elements and Element State

Both alarms and algorithms can contribute to the state (condition) of an element.

Alarms are events associated with specific elements. Each alarm has a severity level. Monitoring an
element’s state often involves analyzing the alarms associated with the element. For more
information on alarms, see Chapter 6, “Filtering and Managing Alarms,” on page 67.

An algorithm is a sequence of actions that an element can use to change the calculation of its own
state. The default method of calculating the state of an element is to use the state of the most critical
child element. For details on algorithms, see “Using Algorithms to Calculate Element State” in the
Operations Center 5.0 Server Configuration Guide.

The following sections describe using the Operations Center console to monitor elements and
element state:

¢ Section 4.1, “Monitoring Elements,” on page 43

¢ Section 4.2, “Viewing Element Properties,” on page 48

¢ Section 4.3, “Filtering Elements by Condition,” on page 50

*

Section 4.4, “Exploring Hierarchies Using the Network View,” on page 51

*

Section 4.5, “Managing and Unmanaging Elements,” on page 54

*

Section 4.6, “Viewing Root Cause and Impacted Elements,” on page 55

Monitoring Elements

The elements available to monitor depend on your access permissions.
The following topics are related to the basic monitoring of elements:

¢ Section 4.1.1, “Understanding Adapter and Service Model Elements,” on page 43
¢ Section 4.1.2, “Understanding Element Condition,” on page 44

¢ Section 4.1.3, “Reviewing Element Information,” on page 45

Understanding Adapter and Service Model Elements

In the Explorer pane, you are likely to have access to the following types of elements:

¢ Adapter Elements: Elements displayed under the Elements root element originate from adapters
and are referred to as adapter elements. These elements can be linked to from the Services
hierarchy.

¢ Service Model Elements: Administrators can create or import elements in the Services > Service
Models hierarchy. These Service Model elements can have custom property pages.

For more information about Service Model elements, see the Operations Center 5.0 Service
Modeling Guide.
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For information about various display options in the Explorer pane, see Chapter 3, “Customizing the
Console Views,” on page 29.

Understanding Element Condition

In the console, color-coded element conditions help identify critical system events. These condition
indicators display for each element in the Explorer and View panes. Condition indicators display as
colored diamonds next to each element:

Figure 4-1 Condition Indicators in the Explorer Pane

2@ [ Elements
. -8 Adapter: BMC Remedy Adapter 7+
@ () Adapter: BMC Software PATROL(r)
- & Adapter: Bugzilla
% Adapter: CA Unicenter NSM(tm)
- [23] Domain
> [ AwNsm@QAZINTELS

AR I bl

For instructions on hiding or showing the diamond condition indicators in the Explorer pane, see
Section 3.1.1, “Hiding or Displaying Condition Indicators,” on page 29.

Condition indicators also display in:

¢ The Condition/Severity column of the View pane

¢ The element property pages (see Section 4.2, “Viewing Element Properties,” on page 48)

Table 4-1 describes the standard element condition colors and their default definitions from most
critical to least critical.

Table 4-1 Default Element Condition Colors

Color Element Status
Red CRITICAL

Orange MAJOR

Yellow MINOR

Blue INFORMATIONAL
Green OK

Gray UNKNOWN
Brown UNMANAGED
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In many cases, Administrators link an Elements element or Services element as a child of another
Services element. In this case, the child to contribute to the condition of the new parent. In the
Explorer pane, a linked element icon displays by these elements, indicating that the element was
created elsewhere in the hierarchy and later linked to this parent using the Link option.

Figure 4-2 Linked Element Indicators in the Explorer Pane

=4 éTa Service Models
—Q Infrastructure Components
. 24 = Application Servers
- o B gaintel1
+ o2 @ = gaintel3

Removing the link allows the child to still display in that part of the hierarchy, but with its condition
no longer affects the parent, as symbolized by the nonsource element link icon in the Explorer pane:

Figure 4-3 Nonsource Element Indicator

=@ = Management System Status

+- /£ f3 none
-4 £ G ga, Toronto
-4 £ G §, Utah

5

b A £ A3 Virginia
For more information about hiding and showing linked element indicators, see Section 3.1.2,
“Displaying Linked Element Indicators,” on page 30

For more information about hiding and showing nonsource elements indicators, see Section 3.1.3,
“Displaying Nonsource Element Indicators,” on page 30.

Reviewing Element Information

After selecting an element in the Explorer pane, the View pane updates to display information about
the selected element’s children. The information varies among views:

¢ “Understanding the Summary View” on page 46
¢ “Understanding the Network View” on page 47
¢ “Understanding the Layout View” on page 48
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Understanding the Summary View

The Summary view displays the first-level child elements of the element selected in the Explorer pane.

Figure 4-4 Summary View

@ Movell® Operations Center @M

File Edit Go View Format Element Window Help
& up {3 Home ] Q, Find ] &) chat ] Fiter: [F] 1 [0 o [Fo ]2 [F]o [Flo

E.H;::;f:: & Adapter: CA Unicenter NSM(tm) - Narmal

(] Enterprise Element + Condition Last Reportad Notes
O Administration [E3] Domain 12/21/2010 3:23:23PM Normal
=+ (]} Elements 2 1PX_Network 12/21/2010 3:23:23PM Nermal
@ Adapter: BMC Remedy Adapter 7+ S TCPJTP Network Critical 12/21/2010 3:23:23PM Normal

BMC Software PATROL(r)

- Adapter:
_0 5 [E5] WBEM 12/21{2010 3:23:23PM Marmal

el ) B (tm)

- & Adapter: Customer Data

< Adapter: EMC SMARTS InCharge(tm)

-> ¥ Adapter: HP OpenView Operations for LUNIX(;
- ¢ Adapter: Lab Status

[ Adapter: Microsoft Operations Manager SCOI
0% Adapter: NetIQ(r) AppManager(r)

- lz] Adapter: NOC - InterConnection Adapter

-3 U Adapter: Tideway Foundation
(o] Service Level Agreements
@

Services

a

| I | » el B8 Portal | °i° Network o5, Layout | L Performance

‘ |49\ements, no selection |adn1in logged in to testdemo since 12/23/2010 1:43:35 PM

By default, it displays four informational columns, summarized in the following:

*

Element: Displays the element name.

*

Condition: Identifies the element’s current condition.

¢ Last Reported: Displays the time of the most recent element condition update.

*

Notes: Provides a brief remark regarding the element’s condition.
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Understanding the Network View

The Network view provides a graphical view of elements and their relationship to other elements
within the larger infrastructure. It presents the selected element at the center of the view, with lines
connected to first-level child elements. The line colors identify the condition of the child element:

Figure 4-5 Network View

@ Movell® Operations Center |E@‘éj

File Edit Go View Format Element Window Help

E Netwaork View +

—---0@ Enterprise
o> Administration
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i @[ Adapter: BMC Remedy Adapter 7+
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v €@ Adapter: Bugzila
0% Adapter: CA Unicenter NSM({tm)
v Adapter: CiscoWorks2000 DFM(tm)
¥ £ Adapter: Customer Data
d Om Adapter: EMC SMARTS InCharge(tm)
7] > € Adapter: HP OpenView Operations for UNIX(j
- {3 Adapter: Lab Status
- [ Adapter; Microsoft Operations Manager SCOI
iy Adapter: NetIQ(r) AppManager(r)

@] Adapter: NOC - InterConnection Adapter

0 -OU‘H Adapter: Tideway Foundation
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P[5y Services

-]

|

I

H

« I 3 BH Portal

admin logged in to testdemo since 12/23/2010 1:43:35 PM
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User access privileges determine which elements display in the Network view. The currently selected
level of the element hierarchy in the Explorer pane determines whether the entire network displays,
or only a portion of it.

Understanding the Layout View

The Layout view uses icons to represent system elements and how they relate to each other:

Figure 4-6 Layout View

@ Novell® Operations Center

Eile Edit Go View Format Element Window Help
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<% Adapter: HP OpenView Operations for Ul

@ ¢z Adapter: Lab Status # Jié)
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@ 7 Adapter: NetIQ(r) AppManager(r)
o% Adapter: NOC - InterConnection Adaptei
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< n v

Navigator | Graphics | Unplaced Elements
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5
BE

125% Switch to Edit Mode Switch to Source

GEIE|

admin logged in to testdemo since 12/25/2010 9:55:52 PM

The Layout view is available for all elements, including;:

¢ Services > Locations: Displays a global map. Each color-coded geographical site identifies the
most severe condition among its child elements.

¢ Services > Service Models: Displays icons representing any element and type of relationship
among elements, such as functional organizations or processes. Customize the view using
drawing tools.

For more information, see the Operations Center 5.0 Custom Drawing and Layout Guide.

4.2 Viewing Element Properties

Property pages display detailed information about an element: Information displayed and the
various pages available depend on the type of element. Administration property pages are found
under an Administration folder.

¢ Section 4.2.1, “Viewing Element Properties and Property Pages,” on page 49
¢ Section 4.2.2, “Copying Element Properties,” on page 49
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To view element properties:

Viewing Element Properties and Property Pages

1 Right-click an element in the View pane, then select Properties to open the Status property page.

AL Properties for [PX_Network

=NEEl X

5 s

----- [E Root Cause
----- |8 Impacted
----- B comments
=13 Administration
i--[@ Service Level Agreements
i [ Blackout Calendar

1P¥_Metwork=IPX_MNetworkiunicenter=Adaptert3A+CA+Unicenter+NSM%28tm%29/root=Elements

cknowledge:

- |8 Access Contral acknowledge
- B Automation admin_status:
‘[ Performance .

posted:
propagate_status:
propagated_sev:
propagated_status_no:
severity:

status_no:

Mormal

The left pane displays the names of available property pages to display the current property

page in the right pane.

The title displays the element’s short name, condition, and Distinguished Name (DName). Each
element has a unique, fully qualified, internal DName, which defines the element’s place in the
hierarchy. The DName is read-only, but can be selected and copied to the Clipboard. The DName
can be difficult to read, so the element name displays everyplace the DName displays.

2 Click a page name in the left pane to view the selected property page.

Administration property pages are under an Administration folder. Click [#| next to the property

page name to expand the property page list.

Users with appropriate access rights can edit the Access Control and Automation property pages.

4.2.2 Copying Element Properties

Text-based element property values can be copied to the Clipboard for pasting in other applications:

¢ “Copying a Single Text Property” on page 50
¢ “Copying All Text Properties” on page 50
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4.3

43.1

4.3.2

Copying a Single Text Property

To copy a text property on the page:

1 Right-click a property, then select Copy to place the text on the Clipboard.

2 Paste the text in any other application.

Copying All Text Properties

To copy all text properties on the page:

1 Right-click the right side of the page background, then select Copy All.
The Copy and Copy All options are also available for text-based alarm properties.

Filtering Elements by Condition

In the Summary, Network, and default Layout views; all elements display by default.

In the top toolbar, Filter toolbar buttons represent the different condition levels (Critical, Major,
Minor, and so on) by showing the associated color. In the Summary view, the number of elements for
each condition displays next to button.

Use these Filter toolbar buttons to display or hide elements in the view based on condition.
For more information, see Chapter 6, “Filtering and Managing Alarms,” on page 67.

You can perform the following actions using the Filter section of the toolbar:

*

Section 4.3.1, “Displaying All Elements,” on page 50

*

Section 4.3.2, “Hiding Elements,” on page 50

*

Section 4.3.3, “Displaying Elements of a Selected Condition,” on page 51

*

Section 4.3.4, “Displaying Elements of a Specified Severity,” on page 51

Displaying All Elements

To display all elements:

1 Right-click any location in the Filter section of the toolbar, then select Reset Filter Settings.

Hiding Elements

To hide elements:

1 Click a colored icon to hide elements having that condition:

Fitter: 7] 0 [F] o [0 [F]o o [F]o [Fo

Operations Center 5.0 User Guide



4.3.3

4.3.4

4.4

Displaying Elements of a Selected Condition

To display elements of a selected condition:

1 Select or deselect the filter buttons:
¢ Elements with the selected condition display.

¢ Elements with the deselected condition disappear from the view.

Displaying Elements of a Specified Severity

To display elements od a specified severity:

1 Right-click any location in the Filter section of the toolbar, then select Critical/Major/Minor:

Fitter: [F] 1770 [I] 8955 [WF) 7681 _[F]2103

Reset Filter Settings

arms: 1,770 critical 8,955 major
! ! Critical/Major/Minor

Only the elements with CRITICAL, MAJOR, or MINOR severity display.

Exploring Hierarchies Using the Network View

The Network view provides a dynamic graphical interface that enables moving across the entire
enterprise, managing applications, servers, and network components.

The Network view displays relationships among system components within a large infrastructure.
The Network view displays the selected element at the center, with spokes connecting to first-level
child elements. Additional lines connect the first level elements to their children. The line colors
identify the conditions of the child elements.

The Network view might not be available to users who are not in the administrators group if it was
disabled. For more information, see “Disabling the Network and Layout Views” in the Operations
Center 5.0 Server Configuration Guide.

The element selected in the Explorer pane determines which elements display in the Network view
and whether the entire network displays or only a portion of it. The elements displayed in the
Network view also depend on user access privileges.

There are various ways to move around the Network view. Use menu options and toolbar buttons to
view different levels of detail.
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Initially, the element selected in the Explorer pane displays in the center of the Network view:

Figure 4-7 Network View

@ MNovell® Operations Center |£@I&J

File Edit Go View Format Element Window Help
<3 Back Fup {IHome | QFing | ) chat | Fier P MEMFIE zoom [l =5 1] [R]Reset [ Newmorkvew -

Sefest rout element. & Adapter: CA Unicenter NSM(tm) - Normal

Eﬁ; Enterprise -

= 0[;:}% Enterprize

4 --O}% Administration

—I- [ Elements

+- A5 Adapter: BMC Remedy Adapter 7+

] @/ ) Adapter: BMC Software PATROL(r)

v & Adapter: Bugzila . ||‘

g : CA Unicenter NSM(tm)

: CiscoWorks 2000 DFM(tm)

: Customer Data

+ EMC SMARTS InCharge(tm)

+ HP OpenView Operations for UNIX (1
@ & Adapter: Lab Status _
<» [ Adapter: Microsoft Operations Manager 5COI

P Adapter: NetIQ({r) AppManager(r) -

@ 0% Adapter: NOC - InterConnection Adapter

4---0?!!! Adapter: Tideway Foundation

[ Service Level Agreements

-+ |F5g Services

FE|PH_Metwork

a m b a CEREUEN i Network |+* Performance

| |admin logged in to testdemo since 12/23/2010 1:43:35 PM

The following sections describe how to use the various features of the Network view:

¢ Section 4.4.1, “Changing the Viewing Level of the Elements,” on page 52

¢ Section 4.4.2, “Selecting the Magnification Level,” on page 53

¢ Section 4.4.3, “Shifting the View to Follow Condition Changes,” on page 53
¢ Section 4.4.4, “Changing the Network Orientation,” on page 54

4.4.1 Changing the Viewing Level of the Elements

You can view elements at a higher or lower level than the selected element. Table 4-2 provides some
examples.

Table 4-2 Network View Actions

Action Result
On the toolbar, click the Up button. The selected element’s parent moves to the center of the Network
view.

On the toolbar, click the Home button. The top-level view displays.

The Elements element displays at the center of the Network view with
lines connecting to the first level elements.
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Action Result

Click and drag the network to center a A new section displays at the center of the Network view.
different section on the screen.

Click an element once. The element moves to the center of the Network view.

The network diagram shifts accordingly, bringing into view the
elements connected to the selected element.

Double-click an element. The selected element moves to the center of the network and its child
elements display.

Click anyplace on the network The Network view shifts in the selected direction.
background in the direction in which ] ] ) ) o
the network should move. For It brings into view elements that were not previously visible.

example, to scroll to the right, click
anyplace in the right side of the
network background.

Selecting the Magnification Level

Use the Zoom slider to increase or decrease the level of detail displayed in the Network view:

Figure 4-8 Zoom Slider

Zoom [T T2 111 171] []Rese

Table 4-3 provides some examples of how to use the slider.

Table 4-3 Zoom Slider Actions

Action Result

Move the slider to the right. Magnifies (zooms in) the Network view.

Fewer elements display, and the lines connecting them enlarge.
Move the slider to the left. Shrinks (zooms out) the Network view.

More elements display and the lines connecting them shrink.
On the toolbar, click the Reset button. Returns to the default magnification level.

The default view displays.

Shifting the View to Follow Condition Changes

You can enable the Follow Condition Changes menu option to immediately move any elements that
experience condition changes to the center of the Network view:

¢ “Automatically Shifting the View to Follow Condition Changes” on page 54
¢ “Causing Elements to Blink When Condition Changes Occur” on page 54
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4.5

Automatically Shifting the View to Follow Condition Changes

To shift the view to follow element condition changes:

1 Click Format, then select Follow Condition Changes.

Enable the Highlight Condition Changes feature to cause elements to blink when their conditions
change. However, the Network view does not move these elements to the center of the screen.

Causing Elements to Blink When Condition Changes Occur

To blink elements when element condition changes:

1 Click Format, then select Highlight Condition Changes.

In the Network view, elements whose condition change blink.

Changing the Network Orientation

Use the Format menu options in the console’s menu bar to change the orientation of elements
displayed in the Network view.

To change the orientation of displayed elements:

1 From the Format menu, click Orientation, then select one of the following:

Radial: The selected element displays in the center of the screen, with lines connecting it to other
elements in a circle.

Top-Down, Bottom-Up: The selected element displays at the top or bottom of a vertical
hierarchy, with lines connecting it to other elements.

Left-to-Right, Right-to-Left: The selected element displays in the far left or right of the screen in
a horizontal hierarchy, with lines connecting it to other elements.

Managing and Unmanaging Elements

For some management systems, conditions are not tred for unmanaged elements. Eliminating the
conditions for some elements reduces the bandwidth and processing time required. You can identify
elements as managed using the Manage right-click option, which displays regularly updated
condition information.

The managing and unmanaging of elements applies to the following enterprise management
systems:

¢ Computer Associates” Unicenter (any version) running on a supported platform

¢ Hewlett Pard OpenView Network Node Manager (version 6.0) running on supported platforms

¢ Tivoli NetView (versions 5.0) running only on UNIX integrations (the AIX and Solaris
platforms)

Using this option requires the Manage permission.
To manage or unmanage an element:

¢ Section 4.5.1, “Managing an Element,” on page 55

¢ Section 4.5.2, “Unmanaging an Element,” on page 55
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45.1 Managing an Element

To start managing an element:

1 Right-click the element, select Manage, and then select Start Monitoring.
The element’s condition changes from UNMANAGED to an updated condition.

45.2 Unmanaging an Element

To stop managing an element:

1 Right-click an element, select Manage, and then select Stop Monitoring.

The unmanaged element and its children display, but Operations Center does not update their
conditions. Their conditions change to UNMANAGED.

4.6 Viewing Root Cause and Impacted Elements

Operations Center provides features for identifying the root cause of a service failure as well as the
impact of an element’s failure:

+ Show Root Cause: Provides a quick way to identify elements that caused a change in the
condition of a higher-level element.
This option is not available for the Enterprise, Administration, and Elements root elements.

¢ Show Impacted: Helps to identify the business services impacted by the failure of lower-level
services.

Use these features together to identify dependencies among service objects and to manage the impact
of an object on overall service delivery:

¢ Section 4.6.1, “Identifying Service Root Causes,” on page 56

¢ Section 4.6.2, “Identifying Impacted Services,” on page 57

¢ Section 4.6.3, “Navigating Impacted or Root Cause Elements,” on page 59

¢ Section 4.6.4, “Restricting the Show Impacted Feature,” on page 60
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4.6.1 Identifying Service Root Causes

Use the Root Cause feature to identify lower-level objects that caused a change in the condition of a
higher-level object.

Element hierarchies display in their entirety. The Root Cause feature ignores the Display Elements as
Children setting for all objects in a hierarchy.

To view Root Cause information:

1 Right-click an element in the Explorer pane, then select Show Root Cause to open its dialog box:

#® Root Cause = | B S

Root Cause Information For:

@ [ Adapter: CA Unicenter NSM{tm)

Root Causes:

& g DEVTEST - Condition updated by management system -
@& g DEVTOWERS - Condition updated by management system

@& g TOWERQAS3 - Condition updated by management system

@ Q devtower 15.mosol. com - Condition updated by management system
P Q devtower5.mosol.com - Condition updated by management system
@& g leghorn.mosol.com - Condition updated by management system

@& g prodman1.mosol.com - Condition updated by management system
@ g supportioan.mosol.com - Condition updated by management system

@ (8 ving - canditinn undated hy mananement svstem
4 m F

m

Details:
@ ﬁ Adapter: CA Unicenter NSM({tm) - Highest Children Severity
@ 3 TCP/IP Network - Highest Children Severity
@ J=f 192,168.10 - Highest Children Severity
@ a"?l 192.168.10.0 - Highest Children Severity
@ of 192.168.10.0:5egment. 1 - Highest Children Severity
@ Q DEVTEST - Condition updated by management system
@ g DEVTOWERS - Condition updated by management system
@ a TOWERQAS3 - Condition updated by management system

@& (8 devtower15.mosol.com - Conditinn tndated by mananement sustem
4 n F

Refresh Close:

m| »

=

The Root Cause dialog box consists of the Root Causes and Detuails sections.

2 Use the information in the dialog box to identify lower-level elements that affected the change in
the higher-level element’s condition:

Root Causes: Identifies the elements that affected the selected element’s state. In the previous
illustration, New York Center is down because Port 5 is down and Port 8 is malfunctioning.

Details: Identifies the hierarchy of the elements involved. Users who do not have the
appropriate security permissions to view an element that is the root cause cannot view the root
cause tree that is normally displayed in the Details pane.

3 Click Refresh to update the following information:
+ The state of the selected element and the root cause of the selected element’s state

¢ The service hierarchy definitions in which the selected element participates (Hierarchy files
are described in the Operations Center 5.0 Adapter and Integration Guide)

¢ The state of the root cause element in the service hierarchy definition that impacts the
selected element’s state

¢ The state of any element in the service hierarchy definition in which the selected element
participates
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4 Perform any of the following actions on elements displayed in the Root Cause dialog box:
¢ Double-click an element.
The view updates to display information for the element.
¢ Position the cursor over the element.
Tooltip information displays for the element.
¢ Right-click an element, then select a menu option.

For descriptions of the menu options, see Appendix B, “Element and Alarm Options,” on
page 123.

5 In the Layout view, display information about an element that is a root cause, perform
management operations on the element, then redisplay information about the high-level object
to determine if its condition changed.

4.6.2 Identifying Impacted Services

The Show Impacted feature identifies higher-level objects that are affected by the condition of a
selected element. Use the Impacted dialog box to change the view to any of the impacted objects.
Perform operations on them, then return to the originally selected object. Drill up the hierarchy to
determine if the selected element impacts multiple services.

Elements in the Elements hierarchy are created using adapters, which are the integration points
between Operations Center and third-party management systems. For event-based adapters or
adapters where the condition is set by a network management system, no elements display as root
causes unless algorithms are set to determine the condition. For more information about algorithms,
see the Operations Center 5.0 Service Modeling Guide.

Impacted information recognizes security settings and displays only the elements that the user is
authorized to view.
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To view higher-level objects impacted by a specific element:

1 Right-click an element in the Explorer pane, then select Show Impacted to open the Impacted

dialog box:

% Impacted =NASINl X |

Elements Impacted By:
@ BE TCP/IP Network

Elements Impacted:
@ g Adapter: CA Unicenter NSM(tm) [details} - Highest Children Severity

Details:
@ [l Adapter: CA Unicenter NSM({tm) - Highest Children Severity
@ 35 TCP/IP Network - Highest Children Severity

All Parents for TCP/IP Network:
@ Adapter: CA Unicenter NSM{tm) @ 345 TCP/IP Network

In this figure, Tools is the selected element. It affects one element at the highest-level. Next to
each element is a description of the algorithm that was applied to determine its state.

Identify objects impacted by the element by reviewing the Impacted dialog box, which consists
of three main sections:

Elements Impacted: Displays the highest-level objects affected by the state of the selected
element and the application of algorithms.

Details: Traverses the element hierarchy beginning with the selected object and finishing with
the top parent just below the Enterprise node. Information about the selected element displays in
a shaded block.

All Parents: Displays all potential services impacted by the selected element. Because every
element, including Enterprise, has a parent, at least one entry always displays in this section.

NOTE: If no objects are impacted, if the impacted objects are not accessible based on security
settings, or if the parent object is Enterprise, both the Details and Elements Impacted sections
display None.

3 Click Refresh to update the following information:

¢ Changes in the state of the selected element and in the impacted services based on the
selected element’s state

¢ Changes in the service hierarchy definitions in which the selected element participates

¢ Changes in the state of any element in the service hierarchy definition in which the selected
element participates
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4 Perform any of the following actions on elements displayed in the Impacted dialog box:
¢ In the Elements Impacted section, click the [details] link next to an element.

The Details section displays the detailed hierarchy between the selected element and the
highest-level element displayed in the Elements Impacted section.

¢ Double-click an element.

The view updates to display the element’s information.
¢ Position the cursor over an element.

Tooltip status information displays for the element.
¢ Right-click an element, then select a menu option.

For details on these options, see Appendix B, “Element and Alarm Options,” on page 123.

4.6.3 Navigating Impacted or Root Cause Elements

In addition to viewing the relationships between elements in the Network view, you can also view the
elements that are affected by the current element (such as the Impacted view), and the elements that
are affecting the current element (such as the Root Cause view).

To view impacted or root cause elements in the Network view:

1 Right-click the Network View drop-down list on the toolbar, and select one of the following;:
¢ Network: Shows standard default view of an element and all its relationships
¢ Impacted: Shows the elements that are impacted by the selected element

¢ Root Cause: Shows what elements are causing the current state of the selected element

MNetwork View

Impacted View

RootCause View

Elements in the view are filtered based on the selection.
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4.6.4 Restricting the Show Impacted Feature

In some situations, you might want to exclude some Service elements from impact reporting. For
example, if you use BSCM to generate automated tree views of elements that are used as building
blocks for higher-level views (applications, services, and so on), the same element can display in the
Show Impacted or Root Cause dialog box for multiple trees.

To exclude an element branch from impact reporting:

1 Right-click an element in the Services hierarchy, then select Properties to open the Status property
page:

.

[ Properties for Aprisma Management Technologies Spectrum(r)+ 7.1.0 =HACH X"

Aprisma Management Technologies Spectrum(r)+ 7.1.0

El labstatus=Aprisma-+Management+Technologies+Spectrum%28r4.29%2B+7.1.0/org=By+Adapter
lgen_alert=Support+Matrixroot=0rganizations

-[§ Comments
-8 Condition
~[g Contact

[ Correlated
~[8 Elements

-[g Impacted
-8 Root Cause
-2 Administration

Element: [= Aprisma Management Technologies Spectrum{r)+ 7.1.0

Last Reported:  12/25/2010 6:00:34 FM

Exdude from impact reporfing {Show Impacted}

2 Select the Exclude from Impact Reporting check box.
3 Close the property page.

4 Click Yes when asked to save changes.
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5.1

Using Find to Search for Elements

The Find feature allows you to search for elements in the Operations Center console. This
functionality is also available when performing other tasks, such as creating behavior models or
selecting a group of elements.

By default, search results are limited to 1,000 items for performance reasons. If you are getting a
result set that is this large or greater, we recommend narrowing the search criteria. If you are not able
to refine the search, we suggest setting up a Service View. For information about building a custom
view, see the Operations Center 5.0 Custom Drawing and Layout Guide and the Operations Center 5.0
Service Modeling Guide.

The following sections explain in detail how to use various Find features to search for elements.
Enhanced searching by metamodel classes and properties is explained in Section 5.3, “Using
Metamodel Classes or Properties as Search Criteria,” on page 65.

¢ Section 5.1, “Conducting a Simple Find,” on page 61

¢ Section 5.2, “Using the Advanced Tab,” on page 63

¢ Section 5.3, “Using Metamodel Classes or Properties as Search Criteria,” on page 65

Conducting a Simple Find

Use the Basic tab to match an element’s name, class, condition (such as CRITICAL and OK), and
property. The more information that you supply in the Basic tab, the more restrictive the search.

To search for elements using the Basic tab:

1 On the console toolbar, click Find to open its dialog box, displaying the Basic tab.
2 Click Browse to open the Browse for Element dialog box.

3 In the left pane of the Browse for Element dialog box, select the root element that contains the
element, which is the target of the search.

4 Click OK to close the Browse for Element dialog box

5 In the Find dialog box, select the Include Sub-Elements check box to search all elements in the
hierarchy.

6 Specify any combination of the following criteria for matching elements:
Name: Specify the name of the element to match:
¢ Specify the complete element name to search for an exact match.

¢ Use an asterisk to represent any number of characters as a wildcard for part of the element’s
name. For example, typing green* finds greenl, greenfield, and greenhouse.

Class: The class name to match.

Condition: Click the drop-down list, then select a condition.
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Property: Specify the element property name.

Select Equals or Not Equals to search for an exact match. Select Contains or Not Contains to search

for a partial match.

Specify the property value.

Matching elements have or contain (or do not have or do not contain) the specified property

value.

Limit: To limit the number of found elements, click the Limit drop-down list, then select a value.
For example, if the limit is 50, the search displays only the first 50 elements found.

Depth: To limit the levels of child elements searched, click the Depth drop-down list, then select

a value.

Time Limit: If the scope of the search is unknown, limit the search time to a specific number of

minutes. Click the drop-down list, then select a value.

7 Click Search to start the search.

Search results display:

@ Find

e |

Element: |[ﬁ] Elements

Include sub-elements

@ QAZINTELD. 192, 168.23.1
@ QAZINTELD. 192, 168.3.20
@ QAZINTELD. 192, 168.36.1
g ga2inteld.mos_galab.com
g qaZinteld.maosol.com

[E gainteld.mosol.com

[E) QAZINTELD-Unispace
QAZINTELD-WEEM
QAZINTELD-WEEM

Search
Mame: Antel®
Class:
Condition: -
- |
Property: equals -
Limit: 50 -
Depth: .10 -
. - 50 objects found.
Time Limit: 1 -
Indude hidden children
Basic | Advanced
Element = Condition Last Repo... MNotes
AwNsm@QA2INTELS 12212010 ... Mormal -
g qazmnTELD 12/21/2010 ... Mormal X

12/21/2010 ... IP_Interface:UnReachabl
12212010 ... IP_Interface:Broken
12212010 ... IP_Interface:UnReachabl
12/21f2010 ... Warning

12(/21/2010 ... Different class found fo..
12/21/2010 ...

12212010 ... Mormal

12212010 ... Normal

12212010 ... Normal -

4]

8 Perform any of the following actions:

+ Double-click an element in the search results.

The Explorer pane updates to display the element.
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5.2

¢ Position the cursor over an element in the search results.
Display status information and the entire path of where the element is located.
¢ Drag an element from the Find dialog box search results and drop it in the Layout view.

Adds the element to a business service view.

Using the Advanced Tab

The Advanced tab provides a text area for entering a search query. Operations Center adheres to the
standard search syntax defined in RFC 2254, The String Representation of LDAP Search Filters. For a
comprehensive description of search syntax, see http://tools.ietf.org/rfcmarkup?rfc=2254.

To search for elements using the Advanced tab:

1 In the Find dialog box, click the Advanced tab to display it:

@ Find [
Element: | Elements Indude sub-elements

Search aiteria: [ Search ]

(&(cn=Toroendo*){objectClass="host*))

0 cbjects found.

Basic| Advanced

Element =  Condition LastRepo... MNotes
s, Toronto oK 12/21/2010 12:02:16 PM
&, Toronto 0k 12212010 12:02:15 PM

The Advanced tab allows more complex searches.
2 Click Browse to open the Browse for Element dialog box, then:

2a In the left pane of the Browse for Element dialog box, select the root element that contains
the element which is the target of the search.

2b Click OK to close the Browse for Element dialog box.

3 In the Find dialog box, select the Include Sub-Elements check box to include all subelements in the
search.
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4 In the Search criteria text area, specify the search criteria using any of the following operators:

>=

The syntax allows entering one or more attribute/value pairs, surrounded by parentheses, and
logically combined with “&” (AND) or “|” (OR) operators. For example:

To find...

Do this....

All objects starting with the same
letters.

All host objects.

All hosts whose names begin with the
letters server.

All hosts whose names begin with the
letters server and are in a CRITICAL
state.

All hosts whose names begin with the
letters server and are in either a
CRITICAL or WARNING state.

Host names that begin with specific
letters and are members of a specific
object class.

Elements that are members of a
specific class and have a response
time greater than or equal to a
specified threshold value.

Specify wildcards using one or more asterisks (*).

For example, to find all objects that begin with server, enter the
query as:

(cn=server¥*)

Specify (objectClass=*host*) to find all host name objects,
all ServerHosts, and so on.

Combine two (attr=value) clauses using the logical AND (&)
operator:

(&(cn=server*)(objectClass=*host*))

Notice how the logical operator appears before the two clauses;
this is called prefix notation.

Enter:

(&(&(cn=server*) (objectClass=*host*))(condition
=CRITICAL))

Enter:

(&(&(cn=server*)(objectClass=*host*)) (] (conditi
on=CRITICAL) (condition=WARNING)))

Enter:
&(objectClass=Router) (hostname>B*)
Enter:

&(objectClass=server)(responseTime>=3.4)

5 Click Search to start the search to display the Search results.

6 Sort the found elements by clicking any column heading.
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5.3

Using Metamodel Classes or Properties as Search Criteria

If the Administrator has enabled enhanced features to find elements based on specific metamodel

classes or custom properties, an enhanced Basic tab displays, as shown in Figure 5-1:

Figure 5-1 Enhanced Basic Tab for Find Feature

@ Find

Element: Services

Indude sub-elements Browse...

Name:
Class:
Condition:
Property:
Lirnit:
Depth:

Time Limit:
Indude hidden children

Element «

ServerGroup

-

Search

Clear

Close

By

Help

HEOEE =
Product Name| v | |equals
Current Version In Lab
Listing
Motes
Previous Version
Previous Version In Lab
Product Mame
Type
Condition Last Reported

4

n

Motes

You can specify search criteria for classes and properties, or click the arrow button, then select

predefined custom class or property.

When typing search criteria in the Class or Property fields, standard * wildcard can be applied. For

example, *Class* matches MyClassName and YourclassName.

In addition, you can filter elements based on multiple condition levels. By default, all conditions are
included. Click a condition color to exclude elements that have that condition from the “found” list.

Instructions for enabling these enhanced Find features are in “Using Classes and Properties to
Enhance Finding Elements” in Operations Center 5.0 Service Modeling Guide.

Using Find to Search for Elements
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Filtering and Managing Alarms

The Alarms view displays a list of all alarms that occurred for an element selected in the Explorer pane
and that element’s children. Customize the Alarms view using display modification and filtering
features. Alarm filtering is discussed in a separate section.

After analyzing alarms, select from several options to indicate the next course of action. The last
section of this section explains how to view historical information about an alarm.

WARNING: If alarms are enabled for Enterprise, Administration, Elements, or Services nodes, verify
there is sufficient memory to process a large number of alarms before trying to view them.

¢ Section 6.1, “Understanding the Alarms View and Alarm Types,” on page 68
¢ Section 6.2, “Viewing a Summary of Alarms,” on page 70

¢ Section 6.3, “Viewing Alarm Severity,” on page 71

¢ Section 6.4, “Performing a Simple Filtering of Alarms by Severity,” on page 72
¢ Section 6.5, “Filtering Alarms,” on page 73

¢ Section 6.6, “Normalizing Time across Computers,” on page 84

¢ Section 6.7, “Performing Alarm Operations,” on page 84

¢ Section 6.8, “Using Alarm Properties,” on page 89

¢ Section 6.9, “Viewing and Managing the Alarm History,” on page 91
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6.1 Understanding the Alarms View and Alarm Types

Alarms are events associated with specific elements. Each alarm has a severity level. Alarms
contribute to the condition of an element. Thus, monitoring an element’s state often involves
analyzing the alarms associated with the element.

The Alarms view displays a list of all alarms that occurred for an element selected in the Explorer pane
and for the element’s children:

Figure 6-1 Alarms View

@ Novell® Operations Center E@g
File Edit Go View Format Element Alarms Window
ftup (i} Home I Q, Find
Sclect root element [# Adapter: CA Unicenter NSM(tm) - Normal
E“ Enterprise -
5 Enterprise Severity T Element Date/Time D Description
-Oﬁ Administration 1212212010 11:58:... 2523 Scan error -200 occurred while processing file: C:OVINDL =
=@ = E1mems 12222010 11:58:... 2524 Scan error -200 occurred while processing file: C:WVINDIC=)|
: ;; 22:22: E:E 2:2;:‘::::5:50’&; 12/22/2010 11:58:... 2525 Scan error -200 oceurred while processing file: C:WIND!
Qg Adapter: Bugzila 12/22/2010 11:58:... 2527 Total Viruses Found: 0
Y Adapter: CA Unicenter NSM(tm) 12/22/2010 11:58.... 2528 Total Infected Files Found: 0
-<> M Adapter: CiscoWorks2000 DFM(tm) 1202212010 11:58:... 2529 Total Scan Error Files: 120
& & Adapter: Customer Data 12/22/2010 11:58.... 2530 Scan Mode: Secure
< Jff Adapter: EMC SMARTS InCharge (tm) 12/22/2010 11:58:... 2631 == Eng Of Summary ==
< &3 Adapter: HP Openview Operations for UNIX(r
O@ Adapter: Lab Status 12222010 11:58:... 8457 Total Files Scanned 109828
e I:I Adapter: Microsoft Operations Manager SCOI 1211672010 1:48:0... 2202 (1) Service Contrel Manager_7034_E: The CA-IPXDiscow
@ |3 Adapter: NetQ(r) AppManager(r) Winor Q gazintels 2232010 1112, 5024 LSASRV_40960_W: The Security System detected an av
O% Adapter: NOC - InterConnection Adapter Info = gazinteis 12232010 3:52:0... 7164 Service Control Manager_7035_I The LiveUpdate service
I ] Info B ganintels 12/2312010 3:512... 7159 Service Control Manager_7035_t The LiveUpdate service
g z::;z:e"e' R Info o) gazintels 127232010 351:2... T160 Service Control Manager_7036_L The LiveUpdate servict
Info Q qa2intels 122302010 2:58:2... 11874 %CASH_| 0050, Autoscan started at 15.00.01 for 12/23/
< Tl ] » Info Q gazintels 12/23/2010 2:58:2... 11875 %CASH_I_0051, Autoscan is complete at 15.00.02
— Info Q gazintels 12/23/2010 11:58:... 5205 %CASH_I_0051, Autoscan is complete at 12.00.08
E = |info Q qazintels 12232010 11:56:... 11128 %CASH_I_0050, Autoscan started at 12.00.06 for 12/23/
Filter Name Type Active Info Q gazintels 12/23/2010 11:58:... 11132 EventLog_6013_I: The system uptime is 25033141 secon
Info Q gazintels 121232010 11:12.... 5025 DnsApi_11160_l The system failed to register pointer (P1
Info Q gazintels 1212312010 10:45:... 10817 Symantec AntiVirus_7_I: New virus definition fils loaded
Info Q qazintels 1212312010 10:34: .. 10746 W3SWVC_1074_|: A worker process with process id of 7
Info Q gaZintel5 12/23/2010 8:58:3... 1039% %CASH_| 0050, Autoscan started at 09.00.07 for 12/23/
._:_l [ I——— inmamninsEes snane ‘ B AACL 1 AREA Audnnnnn in asmolobe of AR ARG : S
Apply ;a‘w:-ut l+¢ Performance
|Last updated 12/23/2010 4:44:53 PM ‘5,142 alarms, no selection |admm logged in to testdemo since 12/23/2010 1:43:35 PM

The administrator defines the events and conditions that trigger an alarm.

Each alarm entry is color coded to identify its severity level. The severity filter buttons (located on the
toolbar) identify the colors representing, from left to right, the most critical to the least critical alarms.

The Alarms view filters alarms based on the alarm type. The following information displays for both
Real-Time and Historical alarms:

¢ Alarms

¢ Audit Events

¢ Outages (available for Historical only)

¢ Change events (Historical only)

For more information, see the Operations Center 5.0 Version Tracking Guide.
¢ Service Level Breaches
¢ Service Level Metrics

¢ Text comments for an element
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If the Service Warehouse database is unavailable, Historical alarms do not display in the Alarms
view. However, it is possible to add new comments for these alarms. The new comments are added to
the Service Warehouse database after it becomes available. An informational log message in the
formula.trc file indicates that Operations Center could not retrieve the alarms because the database
was unavailable. Additionally, no outages are created when the database is unavailable.

By default, Real-Time alarms display in descending order by the date and the time that the most
recently reported alarms occurred. Service level breaches, outages dates, and times indicate when the
breaches or outages occurred. The Alarms view provides information in the columns described in
Table 6-1.

Table 6-1 Standard Alarms View Columns

Column Description

Severity Color codes indicate the severity of the alarm.

Element Identifies the element that generated the alarm.

Date/Time Identifies the date and time when the alarm was reported.

ID Unique identifier that Operations Center generates for alarms.

It is possible to display other columns in the Alarms view. The column names vary, depending on the
management system associated with the alarm. For more information, see Section 3.4.2, “Hiding,
Displaying, and Selecting Columns,” on page 34.
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To change the type of alarms displayed in the Alarms view:

1 In the Explorer pane, select an element.

2 Click the Alarms tab to display the Alarms view.

3 On the toolbar, click the alarms drop-down, then select an alarm type.

Comments

The Alarms view updates to display alarms of the selected type

6.2 Viewing a Summary of Alarms

Alarm totals display in the title bar for all elements showing alarms. The alarms are listed under the
title bar. When an element contains only one alarm, the summary displays the actual alarm.

Figure 6-2 Title Bar: Alarm Totals by Condition

Adap‘ler: BMC Software PATROL(r) - 200 open alarms: 34 critical 65 info 101 OK

Severity
oK
Info
Info
oK
oK
oK
0K

Date/Time Element EID Status » Class
12/26/2010 8:51:0... [ Security 146219 OPEN UpdAppState
12/26/2010 6:51:0... B PAGEpgU=ag... 146820 OPEN UpdParState
12/26/2010 6:51:3... B PAGEpgUsag... 146825 OPEN UpdParState
12/26/2010 6:51:3... _Total 146826 OPEN UpdinstState
12/26/2010 6:51:3... 2 gaintel3 146827 OPEN UpdAppState
12/26/2010 8:51:3.. Paging Files 146823 OPEN UpdinstState
120262010 6:51:3... Paging Files 145829 OPEN UpdAppState

Table 6-2 lists the areas of the console where you can view alarm summaries for an element.

Table 6-2 Alarm Summary Viewing Areas

Area

Explanation and Example

Status Bar

The status bar located at the bottom of the console displays the total number of alarms and
the number of alarms currently selected:

E=WAPoel "% Layout | |+ Performance

IZUU alarms, no selection |admin logged in to testdemo since 12/25/2010 9:55:52 PM
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6.3

6.3.1

6.3.2

Area Explanation and Example

Element Tooltip  When you position the cursor over an element in the Explorer pane, a tooltip displays the
most severe condition of all the element’s children and the total number of open alarms with
the subtotals of each alarm severity level:

S |
Adapter: BMC Software PATROL(r) Critical

Class: patrol
200 open alarms: 51 catical 2 minor 71 info 76 OK
Alarms View Alarm totals display next to the filter buttons:

Filter Buttons

B | Fiter[T]51 [o M2 70 W76 Flo Mo | B Res-tme: Alams v

Adapter: BMC Software PATROL(r) - 200 open alarms: 51 critical 3 minor 70 info 76 OK

These include all alarms with any status type (Open, Acknowledged, and so on).

Viewing Alarm Severity

By default, all alarms display in the Alarms view. Use the Filter toolbar buttons to display or hide
alarms based on severity level. For more information, see Filtering Elements and Alarms.

Figure 6-3 Alarm Severity Filter Buttons

Fiter [F]o [F]o o [F]o o [Flo [F]o

To manage shading and view alarm severity colors:

¢ Section 6.3.1, “Shading or Removing Shading from All Rows,” on page 71

¢ Section 6.3.2, “Viewing Alarm Severity Colors,” on page 71

Shading or Removing Shading from All Rows

By default, only the Severity column is shaded to match the alarm’s severity level. It is possible to
shade all other columns with the alarm’s severity level color.

To highlight or remove severity highlighting of alarm rows:
1 From the Format menu, select or deselect Show Severity Colors.

Another option is displaying the alarm totals by severity in a dialog box that opens over the console.

Viewing Alarm Severity Colors

To view the alarm severity colors and the total number of alarms for each level:

1 From the Format menu, select Show Alarm Summary.
A dialog box opens, displaying the total number of alarms for each severity level.

2 Close the dialog box when finished viewing the alarm totals.
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6.4

6.4.1

6.4.2

6.4.3

Performing a Simple Filtering of Alarms by Severity

In the Alarms views, all alarms display by default.

In the top toolbar, Filter toolbar buttons represent the different severity levels (Critical, Major, Minor,
and so on) by showing the associated color. The number of alarms for each severity displays next to
button.

Use these Filter toolbar buttons to display or hide alarms in the view based on severity only.

For more information about creating more advanced alarm filters, see Chapter 6, “Filtering and
Managing Alarms,” on page 67.

You can perform the following actions using the Filter section of the toolbar:

¢ Section 6.4.1, “Displaying All alarms,” on page 72

¢ Section 6.4.2, “Hiding Alarms,” on page 72

¢ Section 6.4.3, “Displaying Alarms of a Selected Severity,” on page 72

¢ Section 6.4.4, “Displaying Elements of a Specified Severity,” on page 73

Displaying All alarms
To display all alarms:

1 Right-click any location in the Filter section of the toolbar, then select Reset Filter Settings.

Hiding Alarms

To hide alarms of a specified severity:

1 Click a colored icon to hide alarms having that severity:

Fitter: 7] 0 [F] o [0 [F]o o [F]o [Fo

Displaying Alarms of a Selected Severity

To display alarms of a selected severity:

1 Select or deselect the filter buttons:
¢ Alarms with the selected condition display.

¢ Alarms with the deselected condition disappear from the view.
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6.4.4

6.5

Displaying Elements of a Specified Severity

To display elements of a specified severity:
1 Right-click any location in the Filter section of the toolbar, then select Critical/Major/Minor:

Fitter: [F] 1770 [ 8955 [ 7681_[F]

arms: 1,770 critical 8,955 major

2103 Mo [Fl21 M|
Reset Filter Settings
Critical/Majer/Minor

Only the alarms with CRITICAL, MAJOR, or MINOR severity display.

Filtering Alarms

The Alarm Filter pane in the Operations Center console is available only for elements that can display
alarms.

Alarms can be filtered using criteria based on one or more alarm properties, such as severity, element
name, ID, or dates and times. Filtering is useful when you want to see a subset of alarms. For
example, you can apply a filter to display only those alarms with a specified severity level and a time
stamp within a specified date range.

Both administrators and users can create and apply alarm filters. Administrators can create alarm
filters and apply them to service models or metamodel classes to select a subset of alarms. This
provides a way to control the alarms seen by users when they open the Alarms view. Service model
and class filters can be applied in the console, or through scripts.

Users can create and apply alarm filters in their own Alarm views. These filters do not affect other
users’ view of alarms.

Users can define their own alarm filters using the Alarm Filter pane, which is located in the bottom
left corner of the Alarms view:

Figure 6-4 Alarms View

| UM T LA U e — [
--@plo Adapter: NOC - InterConnection Adapter oK 124262010
i Om Adapter: Tideway Foundation oK 1202612010
0 Serv!ce Level Agreements — oK m
[+ @[ Services -
a7 o | + ||info 12/26/2010
— T oo
E = |info 120262010
Filter Name Type Active Info 12/26/2010
¥ 1 Info 12026802010
Open alarms Indude o P———
: s M oK 12/26/2010
oK 127282010
Info 12026802010
12/28/2010
120282010
Info 12026802010
oK 120282010
oK 120282010
LY = Summary BB Portal
Last updated 12/26/2010 5:04:29 PM
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6.5.1

6.5.2

Applying an alarm filter displays a subset of alarms in the Alarms view. For example, apply a filter to
display only those alarms with a specific severity message or class, or alarms within a specific date
and time range. Combine the filter criteria using AND or ANY logic, as explained in subsequent
subsections.

Applying an alarm filter does not change the total number of alarms displayed next to each filter
button at the top of the console. For example, if there are 100 CRITICAL alarms, but an applied filter
removes these alarms from the Alarms view, 100 still displays next to the red filter button in the
console tool bar.

TIP: Click and drag up the top border of the Alarm Filter pane to view many filters. Click and drag
between column headings to resize filter columns.

To filter alarms, review the following sections:

¢ Section 6.5.1, “Displaying or Hiding the Alarm Filter Pane,” on page 74

¢ Section 6.5.2, “Creating an Alarm Filter,” on page 74

¢ Section 6.5.3, “Applying Filters,” on page 81

¢ Section 6.5.4, “Changing Filter Order,” on page 82

¢ Section 6.5.5, “Editing and Deleting Filters,” on page 82

¢ Section 6.5.6, “Reapplying Filters to Update the Alarms View,” on page 83
¢ Section 6.5.7, “Disabling Filters,” on page 83

¢ Section 6.5.8, “Resolving Filters with No Data in Alarms View,” on page 83

Displaying or Hiding the Alarm Filter Pane

To hide or show the Alarm Filter pane:

1 From the Format menu, select Show Alarm Filters.
When selected, the Alarm Filter pane displays.

2 To hide the Alarm Filters pane, deselect Show Alarm Filters from the Format menu.

Creating an Alarm Filter

The options available for a filter depend on the adapter associated with the currently selected
element.

To create an alarm filter:

1 In the Explorer pane, select an element.
2 Click [a] Create in the Alarm Filter pane to open its dialog box.
3 In the Filter Name field, specify a name for the filter.
The name can contain between 1-50 alphanumeric or space characters only.

4 Do one of the following to determine the type of match: Select the Match All radio button to
determine if an alarm must match any or all of the condition statements in order to be selected.

¢ Select the Match any of the following radio button to match one or more condition
expressions. Selecting this option joins more than one statement with an OR operator.
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¢ Select the Match all of the following radio button to match all of the condition expressions.
Selecting this option joins more than one statement with an AND operator.

¢ Select the Custom boolean expression radio button to specify a boolean expression to match.
For more information, see the table in Step 8.

To determine how the condition statements are applied in the filter, do one of the following: or
Match all of the following radio button to determine if an alarm must match any or all of the
condition statements in order to be selected.

¢ Select the Match any of the following radio button to match one or more alarm expressions.
Selecting this option joins the statements with an OR operator.

¢ Select the Match all of the following radio button to match all alarm expressions. Selecting this
option joins statements with an AND operator.

For example, to view alarms that have a specific severity and ID prefix, create two filter
statements, then select the Match All radio button to join the statements with an AND
operator. This is seen as “and” at the beginning of the filter row for the second filter. If you
select Match Any, “or” begins each subsequent filter row.

¢ Select the Custom boolean expression radio button to join the statements using a custom
boolean expression.

Click Add.
A blank row displays for defining a filter statement.
Click the first drop-down list, then select the alarm column name to match in the filter.

The list varies among adapters and also depends on the currently selected element. For example,
select Date/Time for the filter to search alarms based on the date and time they were received:

Alarm Filter (S

Filter name: |Open alarms

(71 Match any of the following @ Match all of the following  (7) Custom boolean expression

the of the alarm [ o=

De-activate this filter on logout

[ QK H Cancel ” Help ]

Depending on which filter you select, other fields are displayed.
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8 Select comparison operators and specify match criteria using the other fields in the row.

When defining the alarm filters, refer to Table 6-3 to understand the relationships among the

fields.

Table 6-3 Alarm Filters - Parameters

Alarm

Match Criteria

Notes

Column Type Operators

Text-based contains

(such as does not contain

Element,

Class, Status, . t

Description) IS n(_) ]
begins with
ends with

is greater than

is greater than or equal
is less than

is Iss than or equal

matches regex

Specify an appropriate
value based on the
selected alarm
column.

Specify an appropriate
value to compare to
the alarm column
value.

Specify a regular
expression to perform
on the alarm column
value.

+ For exact matches, use is or is
not.

* For partial matches anywhere
in an alarm value, use contains
or does not contain.

+ For partial matches using the
first or last characters, use
begins with or ends with.

* For partial matches using the
first or last characters, use
begins with or ends with.

These are lexicographical
comparisons.

In regular expressions, standard
wildcards (?) and (*) are allowed, as
well as standard operators such as
OR, AND, or BETWEEN.
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Alarm

Column Type Operators Match Criteria Notes
Date, Time is Specify a date and To select a date range, create a
is not time. before and an after statement, joined
is before by selecting Match All; or use is
. between.
is before or equal
is after
is after or equal
is less than Specify a date/time These are relative date/time
is more than interval to compare comparisons. For example, to match

Severity

is within the last

is today
was yesterday

is between

is

is not

is higher than
is lower than

with the alarm date/
time.

Specify an aligned

interval based on a
number of minutes,
hours, days, weeks,
months, or months.

Specify beginning and

ending dates to
compare with the
alarm date.

Select from severity
levels appropriate to
the adapter.

dates that are within 30 days earlier
than the current date, use the
criteria: date/time is less than 30
days before the current date.

This is a comparison within an
aligned interval that is inclusive to the
current time interval. For example, to
match dates that are within the
current month and previous month,
select is within the last 2 months. In
this case, if the current date is July
15, the filter searches for dates
between June 1 to July 31, but will
any alarms from June 1 to July 15.

These are comparisons based on the
current date.

This is a comparison based on a date
range.

Use is not to exclude all but one
severity code.

To select a contiguous range of
severity codes, create two
statements using higher than and
lower than, joined by selecting Match
All.
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Alarm

Column Type

Operators

Match Criteria

Notes

Numeric (such contains

as ID)

does not contain

is

is not

begins with

ends with

is greater than

is greater than or equal
is less than

is less than or equal

is between

Specify the number.

*

For exact matches, use is or is
not.

For partial matches anywhere
in an alarm value, use contains
or does not contain.

For partial matches using the
first or last characters, use
begins with or ends with.

For a relative match, use is
greater than or is less than.

To select a contiguous range of
values, create two statements
using greater than and less
than, joined by selecting Match
All; or use is between.

After placing the cursor in the filter
value column (the last column in the
row), specify a value, or an error
message prompts for a numeric
value. It is not possible to edit the
other columns or close the Alarm
Filter dialog box without first
specifying a value.

Some examples of alarm filters:

¢ Matching Alarm Dates and Times: If you select Date/Time in the first drop-down list, you
can select Is Before in the second drop-down list:

- r—

is before or equal
is after

 3/5/2012

—=®H 2:06: 18 M =

Then, if the comparison involves a specific date and time, use the calendar selector to select
a date:
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In some cases, a relative “rolling” date/time comparison is necessary. For example, a filter
could select alarms that are within 30 days of the current date and time. Use the is less than
or is more than operator to specify the time interval for comparing the current date and time.
Also specify whether the filter should pull alarms that are before or after the current date
and time.

The following example filters alarms whose date/time stamp is within 24 hours before the
current date/time:

the of the alarm jis less than

Matching Exact Cases: Case-sensitive matching in alarm filters is optional. When a text
type alarm column is used in a filter, the Case-Sensitive check box is selected by default. This
means that when searching for a specific text string, a match occurs only if each letter in the
string matches exactly the string entered in the third field of the alarm filter.

For example, if the Status alarm column values are all capitalized, such as OPEN, use all
capital letters to enter the value for the alarm filter:

the m of the alarm [ =) OPEN|

If case matching is irrelevant in the search, then deselect the Case-Sensitive check box.

Matching Alarm Severity Codes: When Severity is the selected alarm column, a drop-down
list of severity codes and colors displays in the right column:

the of the dlarm [ - | [l uoknoan ]

The codes vary among adapters.
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9 (Optional) Click Add to create another alarm filter.

The following example shows a filter with two statements:

)
Alarm Filter [

Filter name: |Recent Critical Alarms

(7) Match any of the following @ Ma ng () Custom boolean expression
the .Severity v | ofthealarm |is = u Critical -
and the 'Dateﬂ'lme v | ofthealarm |[is less than -|[ 2 jl .days = \before o | current time

o
Remove

De-activate this filter on logout

[ OK H Cancel H Help ]

The filter matches alarms with a date and time stamp before the specified date and time and a
CRITICAL severity.

10 If the Custom boolean expression radio button was selected in Step 4, specify a boolean expression
using alarm expression ids to indicate how the condition statements are to be applied:

*

*

*

Expression ids display in the front of each condition statement.
Use AND to join two expressions.

Use OR to match any of two expressions.

Use NOT to not match an expression.

The boolean expression is not case-sensitive. Not all alarm expressions must be applied as
boolean expressions can be formed in a way that ignores an expression. For example, if the
following expression is used, (AF1 OR AF2) AND (NOT AF4), then AF3 would be ignored.

In the figure below, the filter allows alarms no older than 24 hours with a severity of
CRITICAL, MAJOR, MINOR and UNKNOWN.
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6.5.3

Alarm Filter

Filker name: |Recent Alarms

(7) Makch any of the following () Match all of the following @) Custom boolean expression
AFL :DateITima v: aof the alarm :is less than v: 1 :I :days v: :bEFOFE v: current time
AF2 .Severity « | ofthe dlarm is - | L] oK =
AF3 :Severity v: of the alarm :is v: u Info =

AF4 of the alarm [ - Iu Unmanaged - I

Enter a boolzan expression using the alarm Filker IDs as operands

AF1 AND (NOT AF2 OR NOT AF3 OR NOT nF‘I)l

De-activate this filker on logout

[ 0K ][ Cancel ][ Help ]

11 (Conditional) To automatically deactivate the filter upon logout from the console, select the
Deactivate This Filter on Logout check box.

To leave the filter activated from session to session, leave the check box deselected.

Deactivating filters upon logout ensures that all alarms display after the next login.

If filters remain active upon logout, the active filters apply automatically upon login and only
the selected alarms display in the Alarms view. Problems might arise from not realizing that all
alarms are not displayed.

12 Click OK to create the filter.

The new filter displays in the Alarm Filter pane.

Applying Filters

After creating filters, you can apply them to the Alarms view using the Alarm Filter pane. Multiple
filters are applied using the AND operator, meaning the resulting alarm set must match all the active
filters. The Figure 6-5 example selects and includes alarms whose IDs begin with 443 and have a
MA]JOR or CRITICAL severity:

Figure 6-5 Alarm Filter Pane: Apply multiple filters at the same time.

] e [x] &5

Filter Mame

Open alarms

Recent Critical Al...

Type
:Indude

:Indude

Active
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6.5.4

6.5.5

After applying a filter, the status bar at the bottom of the Alarms view displays the total number of
alarms selected by the active filters, and identifies in red the number of alarms that are not displayed
because of the filter.

To apply an alarm filter:

1 Do one of the following;:

¢ To include alarms selected by the filter in the Alarms view, click the Type drop-down list,
then select Include.

¢ To exclude alarms selected by the filter from the Alarms view, click the Type drop-down list,
then select Exclude.

&
=
Filter Name Type Active
Open alarms ‘Lndude x|
Recent Critical Al...

Include

2 Select the Active check box to apply the filter.
It is possible to apply more than one filter at the same time.
Alarms must match all active filters in order to be selected.
3 Click Apply.

Alarms are selected based on the active filters and the “included” option. The selected alarms
display in the Alarms view.

Changing Filter Order

Filters apply in the order in which they display in the Alarm Filter pane.
To change the order in which filters apply:

1 Select the filter in the Alarm Filter pane.

2 Click # (the up or down scroll arrow button) to move the filter.

Editing and Deleting Filters

+ “Editing a Filter” on page 82
¢ “Deleting a Filter” on page 83

Editing a Filter
To edit a filter:

1 Select the filter, then click [&| Edit to open the Alarm Filter dialog box.
2 Edit the filter.
3 Click OK to save changes to the filter.

82 Operations Center 5.0 User Guide



6.5.6

6.5.7

6.5.8

Deleting a Filter
To delete a filter:

1 Select the filter, then click %] Delete to open the Delete Confirmation dialog box.
2 Click OK to confirm the deletion.
The filter disappears from the Alarm Filter pane.

Reapplying Filters to Update the Alarms View

Alarm filters are reapplied and the Alarms view is updated when alarm activity occurs, such as when

a new alarm is received, a condition filter is selected in the console toolbar, or the Apply button is
clicked. However, it is possible to set a timer to reapply all alarm filters at a specified interval. This
requires editing the /OperationsCenter_install_path/html/applet_params.xml file.

To specify a time interval for reapplying all alarm filters and updating the Alarms view:

1 Open the /OperationsCenter_install_path/html/applet_params.xml file.

2 Set the following parameter:

param name="AlarmPanel .AlarmFilterTimerFrequency" value="900000"

The time interval is in milliseconds. 900000 equals 15 minutes:

Disabling Filters

To disable alarm filters and display all alarms in the Alarms view:
1 In the Alarm Filter pane, click Reset to clear all Active check boxes.
2 Click Apply.

All alarms display in the Alarms view.

Resolving Filters with No Data in Alarms View

In some situations, applying a filter results in no matching alarms; the Alarms view is blank.
Attempting to edit a filter results in being unable to select a different alarm column value in the
Alarm Filter dialog box.

For example, if Severity is the selected alarm column, it is the only option in the drop-down list.The
reason for this behavior is there are no alarm columns currently available for editing (or creating)
alarm filters.

To restore alarm data:

1 Deactivate the alarm filter by clicking to clear the Active check boxes in the Alarm Filter pane.
2 Click Apply.
The Alarms view updates to display one or more alarms.

It is now possible to edit the alarm filters.
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6.6

6.7

Normalizing Time across Computers

In the Alarms view, new alarms that originate from servers in different times zones are converted to
display a time stamp using the local time zone. For example, a new alarm arriving on a computer in
New York displays a time stamp of 12 noon, but the same alarm displays as 9 a.m. in San Diego.

A timeskew is the difference between the current time on the server and client, regardless of their
time zones. For example, the current time on the server is 8:05 a.m. while the current time on the
client in the same time zone displays 8:07 a.m. By default, Operations Center automatically detects
timeskews and adjusts the displayed time stamp to be the time of the client. The overall effect is to
adjust new alarms so they display using the local current time of the client, adjusting for differences
in time zones and absolute time differences between the server and client. The time skew occurs for
both real-time and historical alarms displayed in the Operations Center console and dashboard.

In some situations, you might want to disable timeskewing. When you disable timeskewing, the time
stamp is based on the time on the server, both for local time and time zone conversions.

By default, timeskewing in enabled.
To disable timeskewing;:

1 From the console toolbar, select Format > Use Timeskew.
The check mark next to the option disappears.

2 After selecting this option, either to enable or disable timeskewing, restart the console in order to
see changes in all places.

Performing Alarm Operations

Alarm options vary by adapter and management system and are available only after selecting one or
more alarms in the Alarms view. For a list of alarm options by adapter type, see Section B.2,
“Understanding Alarm View Menus,” on page 128.

Some options have shortcut buttons listed on the Alarms menu. Also, the appropriate user access
privileges are required for the ability to access some alarm operations.

Figure 6-6 depicts an example of the right-click menu for an alarm:

Figure 6-6 Alarm Element Right-Click Menu

Bugzilla [
Close

Delete
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oK Dar Properties |
Info A s Print I
oK Sol Export to File... ]
Info A ser Export Alarm Filters... |
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This section discusses the following common alarm operations:

¢ Section 6.7.1, “Accessing Alarm Options,” on page 85
¢ Section 6.7.2, “Selecting Alarms,” on page 85
¢ Section 6.7.3, “Pausing and Resuming Alarm Updates,” on page 86
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6.7.1

6.7.2

*

Section 6.7.4, “Acknowledging Alarms,” on page 86

*

Section 6.7.5, “Assigning Alarms,” on page 86

*

Section 6.7.6, “Clearing Alarms,” on page 88

*

Section 6.7.7, “Printing Alarms,” on page 88

*

Section 6.7.8, “Exporting Alarm Data,” on page 89

Accessing Alarm Options

To select alarm options:

1 In the Alarms view, right-click an alarm, then select an option.

Selecting Alarms

There are several ways to select alarms in the Alarms view:

¢ “Selecting One Alarm” on page 85

+ “Selecting Multiple Alarms” on page 85

¢ “Selecting Multiple Adjacent Alarms” on page 85
¢ “Selecting or Deselecting All Alarms” on page 85

Selecting One Alarm

To select an alarm:

1 Click the alarm in the Alarms view.
The selected alarm is highlighted.

Selecting Multiple Alarms

To select non-contiguous alarms:

1 Press the Ctrl key while clicking each alarm.
The selected alarms are highlighted.

Selecting Multiple Adjacent Alarms
To select multiple contiguous alarms:

1 Press the Shift key, then click the first and last alarms.

This also selects all alarms in between the first and last alarms.

Selecting or Deselecting All Alarms

To select/deselect alarms:

1 From the Edit menu, select Select All.
or

Select Deselect All to deselect all alarms.
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6.7.3

6.7.4

6.7.5

Pausing and Resuming Alarm Updates

After alarm selection occurs in the Alarms view, the server automatically pauses all updates to the

Alarms view. On the toolbar, a blinking E Resume button replaces the m Pause button. The status bar
in the bottom left of the console displays a PAUSED message with the date and time.

To resume continuous updating of alarms:

1 On the toolbar, click the E Resume button to update the Alarms view.

On the toolbar, the m Pause button replaces the E Resume button.
2 To resume alarm updates, press the ESC (Escape) key on the keyboard.

Acknowledging Alarms

The Acknowledge operation is useful for technicians who need to indicate that they reviewed, but
did not solve the problem, and perhaps escalated it to the next level.

If another user deletes a paused alarm, the alarm continues to display in the Paused view.

To acknowledge alarms:
1 On the Alarms view toolbar, click the [ Acknowledge button to change the alarm status to ACK
(ACKNOWLEDGED).

Acknowledgements are designed to be short term in duration. Therefore, after the alarm server
completes a cycle, the acknowledged alarm status is lost.

IMPORTANT: T/EC users’ accounts must have Manage permission in order to acknowledge an
alarm.

Assigning Alarms

When supported by the management system, alarms can be assigned to any user who is a member of
the same user group. The ability to assign alarms requires Manage permissions assigned by the
administrator.

NOTE: The following functionality is only available when integrating to management systems —
such as HP OpenView, IBM Tivoli NetView, HP ServiceCenter, and HP Service Manager — that
support the assigning of alarms.

When available, leverage the following functionality to assign alarms:

¢ “Assigning Alarms to Another User” on page 87
¢ “Viewing Users to Whom Alarms Are Assigned” on page 87

¢ “Assigning Alarms to Yourself” on page 87
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IMPORTANT: NetView and OpenView users should note that an operation could be unavailable
based on the current state of the element. If unavailable, the operation cannot be selected from the
menu because it is dimmed.

Assigning Alarms to Another User

To assign an alarm to another user:

1 In the Alarms view, select the alarms to assign.

2 On the toolbar, click the B Assign button.

The Browse for User dialog box opens and displays the names of all users in the system to whom
alarms can be assigned.

3 Select the user’s name.
4 Click OK to close the Browse for User dialog box.

In the Alarms view, an additional column, Assigned To, displays and identifies the users to whom
alarms are assigned.

Viewing Users to Whom Alarms Are Assigned

To view alarm assignments:

1 Do one of the following;:
¢ In the Alarms view, review the Assigned To column for the alarms.

¢ Double-click an alarm to open the alarm’s Properties page. The user to whom the alarm is
assigned is listed.

Assigning Alarms to Yourself

The ability to assign alarms to yourself depends on the adapter type. Some adapters provide the
Assign (or Claim) Responsibility option on the alarm right-click menu or from the Alarms menu.

Depending on the adapter and which alarm columns display, an Assigned column could be available
in the Alarms view. Also view the assignment in the alarm’s Properties page. For more information, see
Section 6.8, “Using Alarm Properties,” on page 89.

You have the following options in assigning alarms to yourself:

¢ “Assigning an Alarm to Yourself and Closing It” on page 88
¢ “Removing the Assignment and Leaving the Alarm Open” on page 88

¢ “Rejecting Responsibility for an Alarm” on page 88
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6.7.6

6.7.7

Assigning an Alarm to Yourself and Closing It
To assign and close an alarm:

1 Right-click the alarm and then select Assign and Close.

Removing the Assignment and Leaving the Alarm Open
To deassign an alarm while leaving it open:

1 Do one of the following depending on the adapter:
¢ Right-click the alarm, then select Deassign.
¢ Right-click the alarm, then select Accept Responsibility.
This option is not available for all adapters.

Accepting responsibility indicates to other users that you are working on resolving the
alarm and will close or clear it. Depending on the adapter and which columns display, a
check mark displays in the Acpt column.

Rejecting Responsibility for an Alarm
To reject an alarm:

1 Right-click the alarm and select Deassign (reject) Responsibility.

Clearing Alarms

Clear alarms assigned to you after resolving the problem. The Clear option is unavailable for Audit
alarms.

To clear alarms:

1 Select one or more alarms in the Alarms view, then click the ﬁ Clear Selected Alarms button on
the toolbar.

The alarm disappears from the Alarms view.

Printing Alarms

Selecting the Print option gives you the option of printing either the selected alarms or all the alarms
in the Alarms view. It is necessary to pause alarm updates before accessing the Print option.

To print all alarms in the Alarms view:

1 Right-click one or more alarms, then select Print.

A message opens with the following question:

Would you like to print just the selected alarms?
2 Click Yes to print just the selected alarms.
or

Click No to print all the Alarms currently showing in the Alarms view to open the Print dialog
box.
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6.7.8

6.8

6.8.1

3 Select a printer, then click Print.

Additional dialog box options are available, such as the number of copies to print and
landscape, portrait, or reverse landscape orientation.

Exporting Alarm Data

Use the Export Data option to export selected alarm data to a comma-delimited file, for further
analysis or printing. First configure the alarm columns using the options listed in Section 3.4,
“Working with Tabular Data,” on page 33. Only the alarms columns displayed in the Alarms view are
exported.

To export alarm data:

1 Right-click an alarm, then select Export Data to open the Save dialog box.
2 Specify a file name, then click Save.
The file format is . csv (Comma Separated Value).

A dialog box opens, informing you that the export process can take considerable time depending
on the number of rows exported.

3 Click Yes to proceed.

A dialog box confirms completion of the export.

Using Alarm Properties

Open the alarm property pages to view information such as the elements affected by the alarm, the
alarm’s owner, and the initial and most recent dates and times. The content of the dialog box varies
among the adapters associated with the selected elements.

¢ Section 6.8.1, “Vewing Alarm Properties,” on page 89

¢ Section 6.8.2, “Displaying a Different Alarm,” on page 90

¢ Section 6.8.3, “Printing Alarm Properties,” on page 91

¢ Section 6.8.4, “Copying Alarm Properties,” on page 91

Vewing Alarm Properties

To view an alarm properties:

1 Do one of the following;:
* Double-click an alarm in the Alarms view.
¢ Right-click an alarm, then select Properties.

The Properties page opens by default.
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Alarm Properties for 192703 SRR X
[ Properties
g Ei:r?;nenm Affected Element: Job Objects
B History LastUpdate:  12/26/2010 3:56:16 PM
Sewerity:
EID: 178042
Host:  gaintell
Application:  NT_JOBS_CONTAINER
Instance: NT_JOBS_CONTAIMER
Parameter:
Arguments:  NT_JOBS_CONTAIMER.MT_JOBS_CONTAINER Current state is inhe
"WmiProviderSubSystemHostlob'.
Class: UpdInstState
Description:  State Change: OK ALARM
Update status for instance NT_JOBS_CONTAINER.NT_JOBS_COMTAIMER. Reast
inherited from instance "WmiProviderSubSystemHostJob',
Catalog: STD
Origin:  NT_JOBS_CONTAINER.NT_JOBS_CONTAINER
Source: 000
Type: ALARM
Status:  OPEM
Owner:  Patrol
Handler:  Patrol
« 1 v
[ < Previous ] [ Mext > ] [ Print ] [ Close ]

2 'To open another property page, click a property page name in the left pane to display the page
in the right pane.

6.8.2 Displaying a Different Alarm

To view the next or previous alarm:

1 Do one of the following;:
¢ Click Next to display the next alarm.

¢ Click Previous to display the previous alarm.

90 Operations Center 5.0 User Guide



6.8.3

6.8.4

6.9

Printing Alarm Properties

To print the alarm properties for the current alarm:

1 Click Print on the property page.

Copying Alarm Properties

Text-based alarm property values can be copied to the Clipboard for pasting in other applications.
To copy a single text property to the Clipboard:
1 Right-click the property, then select Copy to place the text on the Clipboard.

2 Paste the text in any other application.

3 To copy all text properties on the page, right-click the right side of the page background, then
select Copy All.

The Copy and Copy All options are also available for text-based element properties.

Viewing and Managing the Alarm History

If the Data Warehouse is set up to store alarm history, the Alarms view can display the history of an
alarm for a defined time period. Alarm history displays only if the administrator created a profile
that has an associated Alarms expression and also started the profile.

¢ Section 6.9.1, “Viewing the Alarm History for Elements,” on page 92

¢ Section 6.9.2, “Changing the Dates for Displaying Historical Alarms,” on page 93

¢ Section 6.9.3, “Sorting Alarms,” on page 94

¢ Section 6.9.4, “Changing the Maximum Number of Alarms Displayed,” on page 94

¢ Section 6.9.5, “Displaying Record Time,” on page 94

¢ Section 6.9.6, “Viewing Deleted Alarms in Historical Alarms,” on page 94

¢ Section 6.9.7, “Adjusting the Timeline between Real-Time and Alarm History Views,” on page 95

¢ Section 6.9.8, “Viewing the Alarm History Property Page,” on page 95

For configuration settings regarding alarm history data collection, see “Monitoring Alarm History
Collection” in the Operations Center 5.0 Server Configuration Guide.
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6.9.1 Viewing the Alarm History for Elements

To view the alarm history for elements:
1 Inthe Alarms view, select the Historical: Alarms option:

E Real-time: Alarmsz *

E Real-time

Alarms

Audit Events

Alarms

Audit Events

In this example, select Historical Alarms to change the Alarms View display.

2 Click Retrieve to retrieve historical alarms, which shows historical alarms in the Alarms view:

& Open
= [wl[«I[x][m] |33.21 Hpr:c zga.us AM pa|P5e1cF?ra 11:38 AM 30?22231 AM 05 usiplfn‘; 24@7.51 A jgje?fazpsM 01:21 Pupecpzasua AM DB 5,?\&;@7 Dz El
@ ¢ Adapter: bugzlla
@ 0 Customer Issues Severity Element Date/Time D CreationDate Bughumber Status
Waior 607542 121212010 11:16:50 AN 10577 201045120 07542 REOPENED -
| Minor 652110 1212112010 94445 AM 11043 20101118 652110 REOPENED
"D Closed ﬂ Minor 587180 122172010 9:14:44 AM 10996 201003110 587180 REOPENED
‘ Open j Minor 563767 122172010 9:14:44 AM 10995 2009112110 563767 REOPENED
) Resolved [ = major 1212112010 9:14:45 AM 11095 201011216 HEW
@ [ Problem Companents ~| Minor 121212010 9:14:45 AM 11078 2010127 HEW L
9 [ Critsits ~| Minor 121212010 9:14:45 AM___ 11076 20101273 HEW 1
@ [ Platespin ~| Major 1212112010 9:14:45 AM 11075 20101272 HEVI
:g :;:;Temmﬂ 2|~ major 121212010 9:14:45 AM 11042 2010114 HEW
() Test Stotus | Major 121212010 9:14:45 AM 11039 2010110729 HEW
> g Adapter: CA SPECTRUM(t)+ 5.0.0 > Wajor 121212010 11:46:50 AM 10619 2010 HEW
& & Adapter: Customer Data J > Major 1202212010 10:02:19 AM 10733 201010/ NEW i
& Adapter: Lab Status || 4| minor 121212010 9:14:45 AM 11035 201011013 NEW
B:g ::’E;t:;;t\”;;':;ns J + Major 1212412010 11:46:50 AM 10645 201011018 NEW
% € Boston 75131 & Major 121222010 10:02:18 AM 10729 201011018 NEW

Historical alarms display for a specified time period.
The following describes this view:

¢ When an event occurs that triggers an alarm, a new row containing alarm information
displays in the Alarms view.

¢ When the status of an alarm changes, a new row containing alarm information displays in
the Alarms view.

¢ Alarms that contain historical data display in bold.

+ An arrow button ™ to the left of the Severity column indicates that the alarm has more
information.
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¢ You can do the following in this view:

+ Click the *| button to expand and view all entries for the alarm and the various times

that the alarm information was received.

¢ Click the » symbol to expand the view and display additional historical alarms.

* Click the *| button to collapse the alarm history and display only the most recent
entry.

6.9.2 Changing the Dates for Displaying Historical Alarms

To update the date range for historical alarms:

1 Use the timeline buttons to adjust the time range for alarms:

EEEE unday, December 26, 2010 10044 :45 AM EST s
0:42:29 AM 11:36:37 AM 12:30046 PM 12455 PM 214040 FM 30426 FM 3:54:11 PM IE‘

The timeline buttons:

Button Name Description
@ Display Setup Displays the time frame defined by a user-defined Start and End time or the
selection of a saved bookmark.

|E| Bookmark Displays the time frame based on a selected bookmark.

For more information about bookmarks, see Section 7.7, “Navigating with
Charting Bookmarks,” on page 111.

Page Back Moves the timeline backwards by an entire view.
Unit Back Moves the timeline backwards by one unit of time.
Page Forward Moves the timeline forwards by an entire view.

Unit Forward Moves the timeline forwards by one unit of time.

E & & E]

2 Make adjustments by clicking and dragging the timeline to a new position using the following
mouse actions:

Mouse Click Action Function

Click and drag left. Navigates forward.

Click and drag right. Navigates back.

Shift+click m or Shift+click E Seeks the next occurrence of information forward m or

backward III on the timeline.

Ctrl+click and drag left. Zooms out on chart data.
Ctrl+click and drag right. Zooms in to chart data.
Double-click. Opens the Display Setup dialog box.

Filtering and Managing Alarms

93



6.9.3 Sorting Alarms

By default, the Alarms History view lists alarms in chronological, ascending order. This means using
the received time for the alarms to display the oldest alarms first, followed by the most recent alarms.
Sorting service level breaches and outages uses the date and time when the breaches or outages
occurred.

To reverse the alarm history sort order:

1 From the Format menu, select Reverse Alarm History Sort.

When selected, the sort order is chronological, descending. When deselected, the sort order is
chronological, ascending.

The sort order is persistent across client sessions and is unique for each user.

6.9.4 Changing the Maximum Number of Alarms Displayed

¢ “Changing the Maximum Number of Historical Alarms Displayed” on page 94

Changing the Maximum Number of Historical Alarms Displayed

By default, a maximum of 1,000 historical alarms can display.

To change the maximum number of alarms displayed, in the Format menu, click Alarm History Query
Limit, then select a value.

The possible values are 500, 1000, 2500, 5000, and 10,000.

6.9.5 Displaying Record Time

Some network management systems do not issue a new time/date stamp for each change or update
to an alarm. However, it is possible to display and sort historical alarm changes using the date and
time that Operations Center recorded changes for an alarm, called the Record Time.

To display or hide the Record Time column:

1 From the Format menu, select Query by Recorded Date.

When selected, the Record Time column lists the dates and times that Operations Center recorded
each modified alarm.

6.9.6 Viewing Deleted Alarms in Historical Alarms

After deleting a historical alarm, a red x displays in the far left column and a red line strikes through
the alarm column data.

Deleted alarms display data for six columns only: Severity, Element, Date/Time, 1D, Source Element, and
Record Time.

In Figure 6-7, a red strikeout line identifies deleted historical alarms:

Figure 6-7 Alarm History View

FCritical KERNEL 6/18/02 11:55:... 4998 =) gazibm0.m... 6/18/0211:56:0. DPEN
al KERMEL 6(18/02 11:55:49,,, 4558 B qazbmi.mos. .. 6/18/02 11:59:43,,, ACK
EERMEL - el
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6.9.7 Adjusting the Timeline between Real-Time and Alarm History Views

For alarms retrieved in the Alarm History view, the end time displayed in the timeline corresponds to
the date and time when the timeline first displayed.

To view the most recent changes in the Alarm History view:

1 On the toolbar, click the alarms drop-down list, then select Real-Time Alarms to update the

Alarms view.

a A~ W N

Click Retrieve.

Click Retrieve to update the Alarms view.

Make changes to one or more real-time alarms, such as by performing operations on them.

Click the alarms drop-down list, then select Historical - Alarms to update the Alarms view.

The most recent changes do not display because the end time is still set to the previous request’s

end time.

6 Advance the timeline to see the most recent alarm changes.

6.9.8 Viewing the Alarm History Property Page

The alarm History property page displays historical alarm information for a specific alarm.

To view the history of a specific alarm:

1 Do one of the following;:

¢ In the Alarms view, double-click an alarm.

¢ Right-click an alarm, then select Properties.

2 In the left pane, click History.

The History property page displays all available history for the selected alarm:

4

12/3/2010 9:29:12 AM
I

& Alarm Properties for 11020 B )
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i[5 Comments Severity Element DatefTime + CreationDate m Status Bughumber AssignedTo
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Winor P 642243 912972010 1:58:21 PM 1019128 1005 e 642348 Swapn
Winor @ 930/2010 10:41:39 AM 9851
Winor @ 101672010 11:47:47 AM 10019
Winor @ 10/6/2010 11:33:33 AM 9850
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Winor @ 1011912010 9:47:42 AM 9564
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< Previous J [

Next >

] [ Print ] [ Cose

3 To view a different alarm, do one of the following:

* Click Next to view the next alarm.

¢ Click Previous to view the previous alarm.
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Charting Performance Data

The Performance view graphs historical performance data for elements associated with specific
management systems or with the Service Level Manager (SLM), which is a product of Operations
Center for managing service level agreements (SLAs).

¢ Section 7.1, “Understanding the Performance View,” on page 97

¢ Section 7.2, “Understanding the Chart Types,” on page 98

¢ Section 7.3, “Charting Performance Data,” on page 102

¢ Section 7.4, “Viewing and Editing Chart Properties,” on page 107

¢ Section 7.5, “Setting Thresholds on Charts,” on page 108

¢ Section 7.6, “Navigating Performance Charts,” on page 110

¢ Section 7.7, “Navigating with Charting Bookmarks,” on page 111

¢ Section 7.8, “Adjusting Time Intervals,” on page 113

¢ Section 7.9, “Automatically Refreshing Chart Data,” on page 115

¢ Section 7.10, “Using Guidelines,” on page 115

¢ Section 7.11, “Saving the Performance Chart Group to a Graphics File,” on page 116

¢ Section 7.12, “Exporting Data,” on page 116

For details on customizing default chart settings, see “Customizing Default Performance Chart
Settings” in Operations Center 5.0 Server Configuration Guide.

For information on using the Performance view in connection with SLM and SLAs, see “Analyzing
Performance” in the Operations Center 5.0 Service Level Agreement Guide.

Understanding the Performance View

Performance data is available for elements associated with:
¢ Some network management systems, such as BMC PATROL
This data is automatically available for display in the Performance view for the elements
associated with the management system.
¢ The Operations Center Service Level Manager (SLM), which is an optional feature

SLM enables viewing historical performance data saved for elements. Ask your administrator if
the company has purchased and configured SLM.

The key components of the Performance view are:

¢ Explorer pane: Lists elements. Select an element by clicking it. If performance information is
available for a selected element, the associated properties display in the Chart Properties pane.

¢ Chart Properties pane: Lists the types of performance data that can be charted for the selected
element.
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¢ Timeline: Identifies the dates and times associated with the charted performance data. Provides
tools for easy navigation of the Performance charts.

¢ Chart pane: Displays performance data for a selected element using a line chart, sted bar chart,
or condition line chart.

Understanding the Chart Types

Each chart property displays in one of the chart types described in Table 7-1.

Table 7-1 Performance Chart Properties and Associated Chart Types

Chart Property Associated Chart Type

Alarm Column Varies by data type.

A Line chart is created for most columns, except for Severity, which creates a
Condition Line chart.

Alarm Severity Counts Stacked Bar

Child Condition Counts  Stacked Bar

Element Condition Condition (Line or Pie)
Element Condition Condition (Line or Pie)
Change

Element Property Varies by data type.

A Line chart is created for most properties, and a Condition Line or Pie chart is
created for some properties.

Performance Series Line

Script Varies by data type.

Other properties are also available to chart, depending on the properties captured, or if a Service
Level Agreement is defined. For example, when a Service Level Agreement is applied with an
availability objective, Availability and Outage Count properties are often available to chart.

Table 7-2 SLA Property Types and Corresponding Chart Types

Property Type Chart Type
Availability Line
Outage Count Stacked Bar

When charting SLA metrics, it can take up to several minutes before a refreshed or new chart
registers an update, while updates for other property types are received and charted in near-real-
time. In this case, the server has not yet recorded update data for Avai lability and Outage Count
properties.

When charting performance and SLA metrics, if there is no data for the time range selected, the chart
displays with no data.
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The following sections explain the four chart types:

¢ Section 7.2.1, “Line Charts,” on page 99

¢ Section 7.2.2, “Sted Bar Chart,” on page 100

¢ Section 7.2.3, “Condition Line Chart,” on page 101
¢ Section 7.2.4, “Condition Pie Chart,” on page 101

7.2.1 Line Charts

Line charts display property values (other than alarms and condition) for an element. For more
information, see “Creating an Area Line Chart” on page 104.

There are two types of Line charts:

¢ The standard Line chart tracks values using a line on the Y-axis:

¥ Wirite Cache Hit Ratio for MEMwW(Cache

%EWMWMWJ\MMWJW

— % Write Cache Hit Ratio

¢ The Area Line chart fills in the range between zero and the line value:

% Write Cache Hit Ratio for [ MEMWCache

— i Write Cache Hit Ratio
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The Line chart can render both warning and alarm thresholds for some elements (such as Event
Manager and PATROL). In Figure 7-1, when the Write Cache Hit Ratio falls below 20, it issues a
WARNING level (orange) violation. When it falls below 10, it issues a CRITICAL (red) violation.

Figure 7-1 Line Chart: Some Performance Charts Include a Warning and CRITICAL Thresholds

% \rite Cache Hit Ratio for R MEMWCache

1007

807

B0

i I MH JHH (i

% Wirite Cache Hit Retio

d h. ..||H I

7.2.2 Sted Bar Chart

The Sted Bar chart displays segmented values sted in a single bar for each time point.

In Figure 7-2, each sted bar shows the total number of alarms and segments each type of alarm
condition (CRITICAL, MAJOR, MINOR, and so on) by color:

Figure 7-2 Sted Bar Chart

Alarm Severity Courks for B MEMWCache

B Unkwown [ Unmanaged [ OK [ nfa [ Minor 3 Major I Critical

You can identify the changes in the ratio of CRITICAL (red) versus OK (green) alarms over time.
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1.2.3

1.2.4

Condition Line Chart

The Condition Line chart uses a line to tr values over time.

Figure 7-3 shows that the element condition fluctuates mostly between CRITICAL and MAJOR

during the displayed time period:

Figure 7-3 Condition Line Chart

Element Condition for [ MEMWCache

Critical
Major
Minor

Info

QK

Unmanaged

Unknowen

MEMWCache

The background band of colors helps identify the changes in conditions over time.

Condition Pie Chart

A Condition Pie chart is related to the Condition Line chart.

Figure 7-4 shows the element was in CRITICAL and MAJOR condition for equal percentages of time,

and in OK condition for the remaining 20 percent of the time:

Figure 7-4 Average Condition Pie Chart

@ Average Connaction g

0%

- Unknown - Critical - Major Minor
- Info oK - Unmanaged

The Pie chart identifies the percentage of time that the element was in each condition (CRITICAL,

MAJOR, MINOR, and so on) within a specific time period.

For more information, see “Creating a Pie Chart of Condition Values” on page 104.

Charting Performance Data

101



7.3 Charting Performance Data

The following sections describe the steps for selecting elements and properties to create performance
charts:

*

*

*

*

*

Section 7.3.1, “Creating Charts,” on page 102

Section 7.3.2, “Refining the Displayed Chart,” on page 105

Section 7.3.3, “Updating a Chart Group,” on page 105

Section 7.3.4, “Refreshing Performance Data,” on page 106

Section 7.3.5, “Removing Charts,” on page 106

7.3.1 Creating Charts

In the Performance view, the Chart Properties pane lists the types of performance information that has
been gathered for an element, such as the number of alarms for each severity type (Alarm Severity
Counts) and tring the changes in condition for an element (Element Condition).

The following topics are related to creating charts:

*

*

*

*

“Creating a Chart in the Performance View” on page 102

“Adding a Single Chart Quickly” on page 104

“Creating an Area Line Chart” on page 104

“Creating a Pie Chart of Condition Values” on page 104

Creating a Chart in the Performance View

To create a chart:

1 In the Explorer pane, select an element.

2 Click the Performance tab.

The Performance view updates. A timeline selector displays at the top of the view pane.

3 To adjust the timeline to display a specific time frame, do one of the following:

3a Table 7-3 describes the timeline icons you can use to adjust the timeline.

Table 7-3 Timeline Icons

Timeline Icons

Function

Display Setup

Bookmark

Page B
Unit B
Page Forward

Unit Forward

Displays the time frame defined by a user-defined Start and End time
or the selection of a saved bookmark.

Displays the time frame based on a selected bookmark.

For more information, see Section 7.7, “Navigating with Charting
Bookmarks,” on page 111.

Moves the timeline bwards by an entire view.
Moves the timeline bwards by one unit of time.
Moves the timeline forwards by an entire view.

Moves the timeline forwards by one unit of time.
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3b Click and drag the timeline to a position using the actions described in Table 7-4.

Table 7-4 Mouse Click Actions

Mouse Click Action Function

Click and drag left Navigates forward in time.

Click and drag right Navigates b in time.

Shift+click or Shift+click Seeks the next occurrence of information forward or bward in time.
Ctrl+click and drag left Zooms out on chart data.

Ctrl+click and drag right Zooms in to chart data.

Double-click Opens the Display Setup dialog box.

Duplicate property names can exist. Two or more properties attached to an element can
gather properties with the same name. If duplicate properties display in the Chart Properties
pane, the associated profile name displays in parentheses.

4 To automatically display properties in the Chart Properties pane for the element selected in the
Explorer pane, do any of the following:

¢ Select one or more properties in the Chart Properties pane.
¢ To select multiple properties, press the Ctrl key, then click the properties.

¢ To view chart profile information in a tooltip format, position the mouse over a property
name.

The tooltip lists the profile associated with the property:

Properties:

% Cache Hit Ratio
Alarm Severity Cot[;n}ts

Element Condition T
| A property saved by the PatrolElements profile

Create Chart

Consider the following concerning the properties:

¢ Properties originate from either an external management system, such as PATROL, or from
profiles created by the administrator.

¢ If many properties are available, expand the Chart Properties pane by dragging up its top
border.

¢ If performance data is unavailable for the selected element, the Chart Properties pane is
empty, meaning a chart cannot be created.

5 Click Create Chart.
The charts display as a chart group in the Performance view.

Depending on the number of selected chart properties, more than one chart might display. All
charts created at the same time are considered in the same chart group. To understand the
relevance of chart groups, see Section 7.3.3, “Updating a Chart Group,” on page 105.
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When charting SLA metrics (Availability and Outage Count), it can take up to several
minutes before a chart registers an update, while updates for other property types are charted in
near-real-time. In this case, the server has not yet recorded update data for these properties.

6 To create additional charts, repeat Step 1 through Step 5.

Clicking the Create Chart button creates a new chart beneath the most recent chart in the
Performance view. It is considered a separate chart group.

Adding a Single Chart Quickly

To add a chart quickly:

1 Double-click a property in the Chart Properties pane.

The new chart displays in the Performance view. It displays with existing charts, but is a separate
chart group.

Creating an Area Line Chart

The standard Line chart tracks values using a line on the Y-axis. The Area Line chart fills in the range
between zero and the line value.

To create an Area Line chart:

1 Create a standard Line chart.
For instructions, see the steps listed earlier in this section.
2 In the Performance view, right-click the chart, then select Filled.
When selected, the Area Line chart displays. When deselected, the standard Line chart displays.

Creating a Pie Chart of Condition Values

To show average condition values in a pie chart:

1 Create a Condition Line chart. For instructions, see the steps listed earlier in this section.

2 In the Performance view, right-click the Condition Line chart, then select Show Average in Pie Chart:

Refresh Chart Group

Remove Chart Group

I Properties... I

Show Average Condition in Pie Chart...

Export Performance Data...
Table...

A Pie chart opens in a separate dialog box.
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1.3.2

7.3.3

Refining the Displayed Chart

Selecting too many data points can create an illegible chart. Also, all data points might not display in
the chart. Magnify one area of the chart for a better view of data points. Other chart refinements
include hiding profile names in the Chart Properties pane, to make it easier to see when numerous
properties exist.

¢ “Magnifying an Area of a Chart” on page 105
¢ “Displaying or Hiding Profile Names in the Chart Properties Pane” on page 105

Magnifying an Area of a Chart

To zoom and magnify a chart:

1 Use the Zoom feature to magnify the display and refresh the data.

For more information, see Navigating Performance Charts and Navigating with Bookmarks.

Displaying or Hiding Profile Names in the Chart Properties Pane

To hide or show profile names in chart properties:

1 Right-click the background of the Chart Properties pane, then select Show Profile.
When selected, the profile names display.

Updating a Chart Group

Charts display in chart groups in the Performance view. Clicking the Create Chart button creates a new
chart group. A chart group can contain one or more charts, depending on the number of chart
properties selected.

After creating a chart group, update charts in the group by making additional property selections or
selecting a different element to chart.

TIP: Position the cursor over a data point to view a tooltip with relevant data for that point in time.
For Condition charts, position the cursor over the actual data point (not the connector line).

To update a chart group:

1 In the Performance view, select the chart group.

The element and properties used to create the charts appear highlighted in the Explorer pane and
Chart Properties pane, respectively.

2 To chart a different set of properties for an element, select or deselect properties in the Chart
Properties pane.

3 To create a chart for a different element:
¢ Select a different element in the Explorer pane.
¢ Then select properties in the Chart Properties pane.
4 Click Apply Changes to update the current chart group with the changes.

For example, select three properties and create three charts, deselect a property, then click Apply
Changes. The chart group redisplays using the last two selected properties, displaying only two
charts.
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7.3.4 Refreshing Performance Data

Data used to create a chart originates from the time the Performance view initially displayed. As time
passes, it is necessary to refresh the chart with the most recent data from the native management
system associated with the charted elements.

To refresh chart data:

1 Do one of the following in the Performance view:
¢ Click a chart and then click Refresh on the toolbar.
¢ Right-click a chart, then select Refresh Chart Group to refresh all charts in the group.

Refresh Chart Group
Remove Chart Group
Properties...

I Show Average Condition in Pie Chart... l

Export Performance Data...
Table...

7.3.5 Removing Charts

To remove a single chart or the entire chart group:

1 Do one of the following;:
¢ Right-click a chart, then select Remove Chart.
The chart disappears from the Performance view.
¢ Right-click a chart, then select Remove Chart Group.

All charts in the current chart group disappear from the Performance view.
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7.4 Viewing and Editing Chart Properties

Access chart statistics through the chart’s property pages.
To view or edit the properties of a chart:

1 In the Performance view, right-click a chart, then select Properties to open the Properties dialog.

2 The Properties tab displays summary information about the chart:

@ Properties [
¢ Properties | Times | Di=ol=y [ Threshold= [ Bookmarks
Element Condition Change Max: Critical Total Data Points: 5
Min: Critical Avg: Critical

First Point: Thu Dec 23 06:20:46 EST 2010
Last Point: Sat Dec 25 15:27:55 EST 2010

100%.

- Unknown - Critical ajor inor
- Infa OK - Unmanaged

For Condition charts, the Properties tab also displays the Pie chart described in Section 7.2.3,
“Condition Line Chart,” on page 101. The minimum and maximum chart values display, along
with total data points and dates and times of the first and last charted values.

3 In the left pane, click Times.

The Times tab displays the current time interval. Change the date range or time interval, if
necessary. For details on editing the Times tab, see Section 7.8, “Adjusting Time Intervals,” on
page 113.

4 Click Apply.

The chart updates using the specified date and time range:

@ Properties Q

| Properties | _F_Tf_{i_ | Display |Thresholds | Bookmarks‘

(@) Use date range

start: | 12/25/2010 —{#] [4:35:50PM =]
End: |12/25/2010 ~{2] | 50555 M =[] Use current date

() Use interval

Last 15 = |Minutes Aligned

Apply Reset
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5 In the left pane, click Display.

The Display tab in the Properties page displays options that enhance the chart display as
described in Figure 7-5.

Figure 7-5 Properties Page - Display Tab

@ Properties @

| Properties ITImESl Display }| Thresholds | Bookmarks

Chart Height: | 315
Maximum Display Value: |5.0E8

Minimum Display Value: 0.0

Background Color:
[ Use gradient fill

[ Show 30
Show major grids

[ Show miner arids

Save to Defaults Reset

6 Specify the following in the fields provided:
Chart Height: Determines the height of the displayed chart.

Minimum and Maximum Display Values: Determines the range of values displayed on the
chart’s Y-axis.

Background Color: The color that displays behind the chart data.
Gradient Fill: Used in combination with the background color.
Show 3D: Select the check box to display three-dimensional shapes.

Show Major and/or Minor Grids: Adds Y-axis lines that improve chart readability when there
are many data points.

7 To apply the current settings to all charts that are subsequently created, click Save to Defaults.
8 Click Apply to refresh the chart using the changed settings.
or

To cancel changes before clicking the Apply button, click the Reset button to revert to the
previously saved settings.

7.5 Setting Thresholds on Charts

¢ Section 7.5.1, “Specifying a Horizontal Line on the Chart that Represents a Threshold Value,” on

page 109
¢ Section 7.5.2, “Selecting a Threshold when Multiple Thresholds Have Been Set,” on page 109
¢ Section 7.5.3, “Drawing a Thicker Threshold Band,” on page 109
¢ Section 7.5.4, “Deleting the Current Threshold,” on page 110
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7.5.1 Specifying a Horizontal Line on the Chart that Represents a Threshold
Value

To setup a threshold line on a chart:

1 In the Performance view, right-click a chart, then select Properties to open the Properties page.

2 In the left pane, click Thresholds to display the Thresholds property page:

[ @ Properties &J‘
| Properties |T|mes I Display [; Thresholds }| Bookmarks
Threshold(s): | No Thresholds hdl lz‘

Threshold Value: |4.0E3

3 Click Add New Threshold.
4 Specify a value in the Threshold Value field.
The line is drawn at this value on the Y-axis.
5 Click the colored rectangle, then select a color from the palette.
6 Click Apply.

A horizontal line in the selected color displays across the chart along the specified threshold
value on the Y-axis.

7.5.2 Selecting a Threshold when Multiple Thresholds Have Been Set

To select a threshold:

1 In the chart’s Thresholds property page, click the Threshold drop-down list, then select a
threshold.

7.5.3 Drawing a Thicker Threshold Band

To expand the width of the threshold band:

1 In the chart’s Thresholds property page, select the Use Threshold Band check box.

2 Specify a second value in the To number box to draw the threshold band between the values
specified in the To and Threshold Value number boxes.
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7.5.4  Deleting the Current Threshold

1.6

7.6.1

7.6.2

To delete a threshold:

1 In the chart’s Thresholds property page, select the desired threshold in the Threshold drop-
down list, then click Delete.

@ Properties &
Froperties | Times | Display | Thresholds | Bookmarks
Threshold(s): | Threshold : 2.22222222F3 - 3.0E8 - | E‘
Threshald Fr... 222222222
Use threshold band
To: |3.0EB
Color: -

The threshold setting disappears from the Threshold drop-down list.

Navigating Performance Charts

¢ Section 7.6.1, “Zooming In,” on page 110
¢ Section 7.6.2, “Scrolling,” on page 110

Zooming In

To zoom in to view increased levels of detail:

1 Click and drag a rectangle over a portion of the performance chart.

The view zooms in to the selected area. This decreases the number of time intervals displayed,
but increases the number of data points displayed.

2 Double-click the chart to return to the previous display level.

Scrolling

To scroll to display a different area of a chart:

1 Press the Shift key while clicking and dragging the chart.
2 Scroll right or left to view additional data along the X-axis.
3 Scroll up or down to view additional data along the Y-axis.

4 Double-click the chart to return to the previous display.
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1.7

7.7.1

1.1.2

Navigating with Charting Bookmarks

Use bookmarks to move to a specific date and time in the timeline. Think of them as shortcuts to
specific areas of a chart. This section explains how to add a bookmark, access a bookmark, manage
existing bookmarks, and open a list for selection of bookmarks.

¢ Section 7.7.1, “Accessing Bookmarks,” on page 111

¢ Section 7.7.2, “Bookmarking the Current View,” on page 111

¢ Section 7.7.3, “Editing a Bookmark,” on page 112

¢ Section 7.7.4, “Deleting a Bookmark,” on page 112

¢ Section 7.7.5, “Displaying the Date and Time in the Performance View,” on page 113

Accessing Bookmarks

To access chart bookmarks:

1 Click the Bookmarks button in the top right corner of the Performance view.

A menu and list of bookmarks display to the left, as shown in the following:

Add bookmark ... IZ‘

[o]

Manage bookmarks ...

Last15 minutes
Last 30 minutes
Last hour
Last 2 hours
Last 4 hours
Last 6 hours
Last12 hours
Last 24 hours
v Lastweek
Last month

Custom...

Auto Refresh...

Bookmarking the Current View

To bookmark the current view:

1 In the Performance view, click the Bookmarks button, then select Add Bookmark from the Bookmarks

drop-down list to open the Bookmark Description dialog box.

2 Specify a name for the bookmark, then click OK.

Bookmark Description Lé]

|6| Add Bookmark.
Four Hours

3 The new bookmark for the current timeline selection displays in the Bookmarks drop-down list.
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7.7.3 Editing a Bookmark

To edit a bookmark:

1 In the Performance view, double-click the timeline or click Display Setup to open the Display
Setup dialog box.

2 Click the Bookmarks tab:

@ Display Setup
Times Bookmarks|

Four Hours
Sat Dec 12 4:25 PM EST 2010 - Sat Dec 25 4:25 PM EST 20... G

Edit

T

Remove

3 To edit a bookmark, select it, then click Edit.
A dialog box with the bookmark’s name displays:

(@ Four Hours [
Description | Four Hours|

Start: s/ 3] [assem
End: s =fF]  |amem =

4 Edit the bookmark name in the Description field or change the start and/or end date and times.

5 Click OK to save the changes to the bookmark.

7.7.4 Deleting a Bookmark

To delete a bookmark:
1 In the Performance view, double-click the timeline or click Display Setup to open the Display
Setup dialog box.
2 Click the Bookmarks tab.
3 Select a bookmark.
4 Click Remove.
A confirmation dialog box displays.

5 Click Yes to remove the bookmark from the list.
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7.1.5

1.8

7.8.1

7.8.2

Displaying the Date and Time in the Performance View

To display in the Performance view the date and time specified by a bookmark:

1 Double-click the timeline or click Display Setup to open the Display Setup dialog box.
2 Click the Bookmarks tab.

3 Select a bookmark.

4 Click Go.

The Performance view updates to display data matching date and time specified by the
bookmark.

Adjusting Time Intervals

¢ Section 7.8.1, “Changing the Chart Time Interval Using a Bookmark,” on page 113
¢ Section 7.8.2, “Changing the Start and End Dates Used in a Chart,” on page 113
¢ Section 7.8.3, “Changing the Time Interval Used in a Chart,” on page 114

Changing the Chart Time Interval Using a Bookmark

To change the chart time interval using a bookmark:

1 In the Performance view, click Bookmark.

A list of commonly used time intervals (such as last x minutes or hours) displays in the drop-
down list.

2 Select a time interval.

The chart updates to display data for the selected interval.

Changing the Start and End Dates Used in a Chart

To change start and end dates on a chart:

1 In the Performance view, double-click the timeline or click Display Setup to open the Display
Setup dialog box:

2 Click the Times tab:

- q
@ Display Setup [
Times | Bookmarks

g
Start: | 12/18/2010 :l@ 2:35:19 M :I
End: | 12/25/2010 :l@ 2:25:13 M :l [ Use current date

") Use interval

Last 15 2| | Minutes Aligned
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3 To select new starting or ending dates, do the following;:
¢ Select the Use Date Range radio button and enter a start and end date/time.
¢ Select the Use Current Date check box to use the current date as the default end date.
4 Click Apply.
The Performance view timeline updates to display the specified dates.
5 Click to close the dialog box.

7.8.3 Changing the Time Interval Used in a Chart

To change the time interval:

1 In the Performance view, double-click the timeline or click Display Setup to open the Display
Setup dialog box.

2 In the Display Setup dialog box, select the Use Interval radio button.
[ @ Display Setup 3w |

Times | Bookmarks

() Use date range

Last | 15[ [Minutes + | [T Aligned

3 Click the drop-down list, then select the time interval: Minutes, Hours, Days, Weeks, or Months.
4 Use the Last spinner to select the numeric increment.
5 Do one of the following:

¢ To use a rolling time interval display, leave the Aligned check box deselected.

¢ To use an aligned display, select the Aligned check box.
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6 The Performance view timeline updates to display the specified time interval.
Click Apply.
7 Click to close the dialog box.

7.9 Automatically Refreshing Chart Data

To refresh chart data at a specific time interval:

1 In the Performance view, click Bookmark, then select Auto Refresh to open the Auto-Refresh dialog
box.

Auto-Refresh Interval &J

|0| Please enter the refresh interval (seconds).
- 60.0|

Cancel

2 Specify the time interval (in seconds).
The minimum interval is 30 seconds.
3 Click OK.

The chart data updates continuously at the specified time interval:

7.10 Using Guidelines

Guidelines provide visual cues to help compare data from multiple charts at the same point in time.

¢ Section 7.10.1, “Creating a Guideline,” on page 115
¢ Section 7.10.2, “Moving a Guideline to a New Position,” on page 116

¢ Section 7.10.3, “Removing One or All Guidelines,” on page 116

7.10.1 Creating a Guideline

To create a guideline:

1 Right-click a point on the timeline at which to compare data, then select Add Guideline.
A vertical guideline displays at the selected point:
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7.10.2  Moving a Guideline to a New Position

To move the guideline:

1 Hover the cursor at the top of the guideline until the cursor changes to a hand symbol and drag
to a new position on the timeline.

7.10.3 Removing One or All Guidelines

To delete the guideline:

1 Do one of the following;:
¢ Right-click the guideline, then select Remove Guideline.

¢ To remove all guidelines, select Remove All Guidelines.

7.11 Saving the Performance Chart Group to a Graphics File

Save the performance chart group currently displayed as a .gif image.
To save the current chart group as a .gif file:

1 Select the chart group.

2 From the File menu, select Save Graphic to open the Save dialog box.
3 Specify a file name with the .gif extension.

4 Click Save to open a confirmation dialog box.

5 Click OK.

All charts in the current chart group are saved in the single .gif file.

7.12 Exporting Data

It is possible to save performance data as a comma-separated text file. Appropriate access privileges
are required to save the performance data. Inadequate privileges results in the message “Failed to
save data. The privilege to do so may have been denied.” when attempting to save
performance data. Contact the administrator to request the permission to export the performance
data.

To export performance data from a chart:

1 Do one of the following;:
¢ Right-click a chart, then select Export Performance Data.
¢ From the File menu, select Export Performance Data to open the Save Data dialog box.
2 Specify a file name with a . txt extension.
3 Click Save to open a confirmation dialog box.
4 Click OK.
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Al

Main Menu Options

Menu options appear throughout the console. Some options display on the menu bar. Options vary

depending on the current view. Right-clicking an element accesses many element-related options.
This section lists and defines the available options.

¢ Section A.1, “Main Menus,” on page 117
¢ Section A.2, “Network View Menus,” on page 120

Main Menus

Table A-1 summarizes the options available from the main menu bar for most views.

Table A-1 Standard Menu Options

Menu Options

File * New Browser: Opens a new browser.
¢ Change Password: Changes the logon password.
* Logoff: Logs out of Operations Center and ends the current session.

+ Logoff and Exit: Logs out of Operations Center and completely exits the program.

Edit

*

Find: Searches for an element based on specified criteria.

* For the Alarms view, the Edit option menu includes the following additional options:
+ Select All: Selects all alarms.

+ Deselect All: Deselects all alarms.

*¢ Pause: Pauses all alarms.

Main Menu Options
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Menu

Options

Go

View

B: Displays the previous view.

Forward: Displays the next view. Used with B to retrace steps during the current session.
Cannot be used when viewing the most recent window.

Up One Level: Moves up one level in the hierarchy displayed in the Explorer pane.
Home: Selects the top level of the current element’s branch in the Explorer pane.

Summary: Changes the view to Summary and displays the child elements of the element
selected in the Explorer pane.

Portal: Changes the view to Portal and provides a gateway into different areas of information
about the selected element. Useful for administrators.

Network: Changes the view to Network and displays a graphical representation of the selected
element in relation to other elements in the network.

Alarms: Changes the view to Alarms and displays a list of alarms for the selected element.
Layout: Changes the view to Layout.

Performance: Changes the view to Performance and displays graphs of performance data, if
available, for the selected element.

Chat: Opens a dialog box for communicating with other console users. Console chat is not
available for communication with dashboard users.

Alarm Window: Opens an independent alarm window for the selected element.

Go To Element: Changes the focus of the view to the associated element.

Toolbars/Standard Buttons: Displays or hides the standard window buttons.
Status Bar: Displays or hides the status bar at the bottom of the console.
Explorer Pane: Displays or hides the Explorer pane.

Default View: Sets the default view that is opened whenever an element is selected in the
Explorer pane. Contains the following suboptions:

+ Specific view name: Aways displays this view by default.
* Auto-select: Selects a view based on the element type.

+ None: Disables the default view. The view does not change after selecting an element in
the Explorer pane.
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Menu

Options

Format

Element

Alarms

Window

The Format options vary depending on the selected view. The Layout view has an extensive set of
exclusive options.

For more information, see the Operations Center 5.0 Custom Drawing and Layout Guide.

*

*

*

Background Color: (Network and Layout views) Provides a color palette for selecting a
different background color.

Condition/Severity Color: Provides a color palette for assignment to the condition or severity
buttons.

Display Text: (Network view) Displays the text associated with objects.
Enlarge Font, or Shrink Font: (Network view) Adjusts the size of the font.

Filter Removing Tree Structure: (Network view) Used in conjunction with the Filter buttons on
the toolbar to remove a filtered element from the tree structure.

For example, click the green filter button. This darkens OK objects, but still displays them in the
Network view. Select this option to remove the filtered objects from the display.

Fit Columns: (Alarms view) Resizes the Alarms columns based on the longest text string in
each column.

Follow Condition Changes: (Network view) Refocuses the view to follow elements whose
status/condition change.

Orientation: (Network view) Sets the view to use a radial, top-down, bottom-up, left-to-right, or
right-to-left display.

Query by Recorded Date: (Alarms view) Sorts and displays historical alarm changes using
the dates and times when Operations Center recorded the alarm changes. Displays these
dates and times in the Record Time column. Available only when alarm history displays in the
Alarms view.

Restore Defaults: (Network and Alarms views) Resets the view to system defaults.

Reverse Alarm History Sort: (Alarms view) Sorts alarm history entries in chronological,
descending order (most recent to oldest). The sort order is persistent across client sessions
and is unique for each user. When this option is deselected, the default sort order is used:
chronological ascending order (oldest to most recent.) Available only when alarm history
displays in the Alarms view.

Set Font: (Summary and Alarms views) Sets the font size and style for the text displayed.

Show Alarm Summary: (Alarms view) Opens a small window displaying the alarm severity
colors and the number of alarm totals for each.

Show Severity Colors: (Alarms view) Displays severity colors across the row of data.

Show/Hide Columns: (Alarms view) Displays or removes columns.

For Element menu options, see Section B.1, “Understanding Element Menus,” on page 123.

These dynamic menu options display when the Alarms view is selected. The options vary depending
on the adapter type associated with the alarm

For more information, see Section B.2, “Understanding Alarm View Menus,” on page 128.

*

New Window: Creates an additional View window.
Close Window: Closes the current window.
Tile: Arranges open View windows in a side-by-side format to fit within the console.

Cascade: Sts open View windows behind the current window.
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A.2

Menu Options

Help .

Open Online Help: Displays the table of contents for the Operations Center online help.

Administrative Tasks: Displays the Operations Center 5.0 Server Configuration Guide in
online help.

Service Configuration Manager: Displays the “Introduction to the Service Configuration
Manager (SCM)” section in the Operations Center 5.0 Service Modeling Guide in online help.

Service Level Manager (SLM): Displays the Operations Center 5.0 Service Level Agreement
Guide in online help.

Data Integrator: Displays the Operations Center 5.0 Data Integrator Guide in online help.
Event Manager: Displays the Operations Center 5.0 Event Manager Guide in online help.
Dashboard: Displays the Operations Center 5.0 Dashboard Guide in online help.

Configuring Adapters: Displays the Operations Center 5.0 Adapter and Integration Guide in
online help.

Cool Solutions Web Community: Displays the Cool Solutions Web Community for BSM on
the Novell Web site.

Novell Operations Center Home Page: Opens the Operations Center product page on the
Novell Web site.

About Operations Center: Displays the current version and client and JAR information.

Network View Menus

The menu options in the Network view help navigate the network elements and provide formatting
options. In the Network view, access menu options using the Format menu or by right-clicking the
Network view background. Table A-2 summarizes the menu options.

Table A-2  Network View Right-Click Menu Options

Option

Description

Home

Display Parent

Zoom In

Centers the top level of the network in the Network view.

When selected from the toolbar or from the Go menu, Home displays the top level of the
entire network.

When selected from the right-click menu in the Network view pane and only a portion of the
network is currently displayed, Home centers the top level of the portion that displays.

For example, select a level 3 element in the Explorer pane, then select Home to center the
level 3 element in the Network view.

Moves up one level in the hierarchy and centers the parent of the currently selected element.
Available as a right-click menu option or as the Up button on the toolbar.
Magnifies an area of the Network view.

Available as a right-click menu option, under View on the menu bar, and as a button on the
toolbar.

Shortcut keys are Ctrl+plus(+).
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Option Description

Zoom Out Shrinks the Network view to display more elements.

Available as a right-click menu option, under View on the menu bar, and as a button on the
toolbar.

Shortcut keys are Ctrl+plus(+).
Reset Zoom Returns to the default magnification level.

Available as a right-click menu option, under View on the menu bar, and as a Reset button
on the toolbar. Clicking the Reset button on the toolbar also resets the displayed elements,
to center the top level elements.

Shortcut keys are Ctrl+minus(-).

Format Displays options for changing the font and background color, and for changing the display
format of the network.

Formatting options are available as right-click menu options and under Format on the menu
bar.

+ Restore Defaults: Returns the view to the default settings.

+ Select Font: Displays the font menu.

+ Enlarge Font or Shrink Font: Changes the font size.

+ Choose Background Color: Displays a color palette for changing the network
background.

+ Follow Condition Changes: Shifts the network display to center the element that
experiences the most recent condition change.

+ Highlight Condition Changes: Displays blinking elements when their conditions
change.

+ Filter Removing Tree Structure: Removes filtered elements from the Network view;
used in conjunction with the Filter buttons on the toolbar.

For example, click the red filter button to darken the CRITICAL elements in the Network
view. Then select Filter Removing Tree Structure to remove the CRITICAL elements
from the Network view.

+ Orientation: Sets the network display type.
Select from any of the following:
+ Radial: Elements fan out from the center.
+ Top-Down: Selected element appears at the top.
* Bottom-Up: Selected element appears at the bottom.
+ Left to Right: Shifts the selected element to the right.
+ Right to Left: Shifts the selected element to the left.

+ Display Text: Displays or hides element names on the screen.
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B.1

B.1.1

Element and Alarm Options

This appendix provides an overview of all element and alarm options. While your Administrator can
create custom options, this gives you a description of standard Operations Center options available
for elements and alarms:

¢ Section B.1, “Understanding Element Menus,” on page 123

¢ Section B.2, “Understanding Alarm View Menus,” on page 128

Understanding Element Menus

Element menu options vary depending on the adapter type associated with the selected element.
Access element menus from the Explorer pane and the Summary, Network, and Layout views. To access
element menus, right-click an element.

¢ Section B.1.1, “Right-Click Element Menu Options,” on page 123

¢ Section B.1.2, “Element Menu Options,” on page 124

¢ Section B.1.3, “Additional Menu Options in the Services Hierarchy,” on page 125

¢ Section B.1.4, “Additional Menu Options for Service Elements,” on page 125

¢ Section B.1.5, “Additional Administrative Menu Options for Elements with Specific Adapters,”
on page 126

Right-Click Element Menu Options

Figure B-1 shows the right-click element menu for an element in the Elements hierarchy in the Explorer
pane:

Figure B-1 Element Right-Click Menu

0@ Enhe_rprise

—0% Administration
@ ]l Elements
- [ Adapter: BMC Remedy Adapter 7+
+-4p [ ) Adapter: BMC Software PATROL(r)
- Adapter: Po-=-
+Q ] Adapter: ¢ Properties
+0m Adapter: ¢ Alarms
- {2 Adapter: ¢
gﬁ Adaster: £ Copy Ctrl+C
] <> €3 Adapter: b MNew 3
+1-d & Adapter: | View R
- (3 Adapter: |
Q% Adapter: Add Comment...
= Adapter: r Create Outage...
---gﬁv?:aafz;. Edit Blackout Calendar...
+---0 Services MNavigate Relationships...

Show Impacted...
Show Relationships...

Show Root Cause...
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Element Menu Options

Table B-1 summarizes the element menu options.

Table B-1 Element Menu Options

Option Description

Properties Opens the element property pages, which display detailed information about each element.
Alarms Displays the Alarms view.

New Opens a new Alarms dialog box for the selected element.

View Changes the view to Summary, Portal, Network, Layout, or Alarms.

Add Comment

Create Outage

Edit Blackout
Calendar

Show Impacted

Show
Relationships

Show Root Cause

Enables creating annotations for the selected element. View comments in the element’s
Comments property page.

Defines a manual outage for an element. For more information, see the Operations Center
5.0 Service Level Agreement Guide.

Defines a blackout calendar requirement which halts data capture at times when the
element has planned or unplanned maintenance, or down time that does not affect any
other elements in the hierarchy. Available for Elements and Services root elements only.

Identifies higher-level objects that are affected by the condition of the selected object. For
details on Show Impacted, see the Section 4.6, “Viewing Root Cause and Impacted
Elements,” on page 55.

Opens the Relationship Browser, which provides advanced layout features that enhance
visualization and navigation of element relationships. For information on the Relationship
Browser, see the Operations Center 5.0 Service Modeling Guide.

Identifies objects that affect the condition change in a higher-level object. For details on
Show Root Cause, see the Section 4.6, “Viewing Root Cause and Impacted Elements,” on
page 55.
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B.1.3 Additional Menu Options in the Services Hierarchy

B.1.4

Additional menu options exist for elements in the Services hierarchy, as shown in Figure B-2:

Figure B-2 Right-Click Menu for Services Elements
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Add Element...
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Remove..
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Service Configuration »

Additional Menu Options for Service Elements

Table B-2 describes the additional menu options for Services elements.

Table B-2 Services Element Menu Options

Option Description

Copy Copies the element and its children. Use Paste to place a copy of the element elsewhere in
the Explorer pane.

Cut Cuts the element and its children. Use Paste to place a copy of the element elsewhere in
the Explorer pane.

Paste Pastes a copy of an element (and its children) as a child of the selected element. Pastes an
element that was copied or cut from a different branch of the Services hierarchy. No link
exists between a pasted element and the element from which it was copied or cut.

Add Element Creates a new element under Locations or Service Models. For details on adding new
elements, see the Operations Center 5.0 Service Modeling Guide.

Manage Creates and manages custom property pages for an element in the Services hierarchy.

Properties These property pages apply to one element only. For more information, see the Operations

Center 5.0 Service Modeling Guide.
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Option

Description

Remove

Remove All
Occurrences

Rename

Its function is context sensitive. A confirmation dialog box lists the elements to remove, so
you have the chance to review and if necessary, cancel the action.

¢ For most elements, Remove deletes the selected element and its children.

+ For a source element that has linked elements created using the Link Here option,
Remove deletes the source element and all its linked elements. For details on the
Link option, see Section 3.1.3, “Displaying Nonsource Element Indicators,” on
page 30.

+ For an element created using the Link Here option, Remove deletes only the linked
element.

Available only for an element that is linked to another Services element. Deletes the current
element, the original element and all other linked copies of the element.

Renames the selected element. Allows the selection of a new class.

Additional Administrative Menu Options for Elements with Specific

Adapters

Table B-3 lists additional administrative menu options for elements using specific adapters.

Table B-3 Adapter Element Menu Options

Option

Description Adapters

Acknowledge

Administration

Indicates that the selected alarms has been reviewed. ¢ BMC PATROL
Changes the Status column value to (Acknowledged). Used
by technicians to indicate that they reviewed, but did not

solve the problem, and perhaps escalated it to another level.

+ Tivoli NetView

Allows monitoring the element's current status (Manage ¢ Computer Associates
option), or stop monitoring an unimportant element to save Unicenter NSM
bandwidth (Unmanage option). For details on managing and

unmanaging elements, see Section 4.5, “Managing and

Unmanaging Elements,” on page 54.
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Option

Description

Adapters

Console

Jobs

Knowledge
Module (KM)

Manage or
Unmanage

Ping

Propagate

Runs a script that executes a console connection, allowing
direct communication with a managed element.

Console capability is available for specific element types
associated with a specific adapter. This means for a specific
adapter, the Console option can be available for some
elements, but not available for other elements. For
information on console parameters for each adapter, see the
Operations Center 5.0 Adapter and Integration Guide.

Opens the console for interacting with Jobs. A job is a
Knowledge Script that has been configured and scheduled to
run once, at regular intervals, or at specific times on a given
set of managed computers. The Knowledge Script contains a
set of functions defined to manage some aspect of a system
or application. Jobs are organized as parents and children,
with only one level of children for any parent.

PATROL agents receive information about the computers and
applications in the environment from KMs. A KM contains
information to identify objects and the actions to perform
when monitored objects change status. The list of KMs
displayed in the element menu varies, depending on whether
existing KMs or custom KMs are used.

Allows monitoring the element's current status (Manage), or
stop monitoring an unimportant element to save bandwidth
(Unmanage). For details on managing and unmanaging
elements, see Section 4.5, “Managing and Unmanaging
Elements,” on page 54.

Opens a dialog box and attempts to contact or “ping” the
selected element to test its network connection. The dialog
box displays the number of bytes received and how long the
message took. Click Stop to stop pinging the element.

Enables or disables the Propagate flag setting for WorldView
objects within the NSM 2-D map. If you are using the
Unicenter adapter, for more information see the Operations
Center 5.0 Adapter and Integration Guide.

BMC PATROL

BMC Patrol Enterprise
Manager (PEM)

Cisco Info Center

Computer Associates
Spectrum

Computer Associates
Unicenter NSM

HP OpenView NNM

IBM Micromuse
Netcool

Operations Center
Event Manager

Tivoli NetView
Tivoli T/EC
Tivoli T/EC+

NetlQ

BMC PATROL

HP OpenView
Operations for UNIX

Tivoli NetView (only
running on AlX and
Solaris)

Computer Associates
Unicenter NSM

Computer Associates
Unicenter NSM
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Option Description Adapters

Query Alert Enables users to query historical alarms in the PEM ¢ BMC Software
History persistent store. Users can specify start and stop date/time PATROL Enterprise
boundaries for displaying historical alarms. Historical alarms Manager (PEM)

are displayed for the length of time specified using the PEM
adapter properties. For more information, see the Operations
Center 5.0 Adapter and Integration Guide.

Severity Enables setting an alarm severity by selecting a submenu ¢ Computer Associates
option (CRITICAL, MAJOR, MINOR, and so on). Unicenter NSM

Trace Route Displays the routing information through the network to the * Computer Associates
selected element. Displays the IP address for each hop, as Unicenter NSM

well as the amount of time taken to connect to each segment.

B.2 Understanding Alarm View Menus

128

In the Alarms view, access menu options using the menu bar or by right-click an alarm. The menu
options vary, depending on the adapter associated with the alarm. Table B-4 summarizes the menu
options and lists the adapters for which the options are available.

Table B-4 Alarm View Menus

Option Description Adapters
Accept Assigns responsibility for the alarm to you. For information on ¢ BMC PATROL
Responsibility assigning alarms, see Section 6.7.5, “Assigning Alarms,” on Enterprise Manager
page 86. (PEM)
Acknowledge Indicates that the alarm has been reviewed. For more ¢ BMC PATROL
information, see Section 6.7.4, “Acknowledging Alarms,” on .
page 86 ging + HP OpenView

Network Node
Manager

+ HP OpenView
Operations for UNIX

+ IBM Micromuse
Netcool

* NetlQ AppManager

+ Tivoli Enterprise
Console (T/EC) and T/
EC+

+ Tivoli NetView

Add Annotation Provides a field for entering information about the alarm. ¢ HP OpenView
Used to document actions and read through previous actions. Operations for UNIX
Add Comment Provides a field for entering information about the alarm. ¢ BMC PATROL
Used to document actions and read through previous actions. Enterprise Manager
To view diary comments, open the Comments property page. (PEM)

* NetlQ AppManager
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Option Description Adapters

Add Diary Provides a field for entering information about the alarm. ¢ BMC PATROL
Document actions and read through previous actions. To
view diary entries, open the Diary property page.

Assign Assigns responsibility for the alarm to a selected user. For BMC PATROL

Assign and Close

Claim
Responsibility

Clear

Close

DeAssign (reject)
Responsibility

Decrease Severity

Delete

Disown

more information, see Section 6.7.5, “Assigning Alarms,” on
page 86.

Assigns the alarm to you, then closes it.

Assigns responsibility for the alarm to you. For information on
assigning alarms, see Section 6.7.5, “Assigning Alarms,” on
page 86.

Removes the alarm from the Alarms view. For more
information, see Section 6.7.6, “Clearing Alarms,” on
page 88.

Changes the alarm status from Open or Acknowledged to
Close, then removes it from the Alarms view.

Removes the alarm assignment from the user selected by the
Assign or Accept Responsibility option. The alarm can be
reassigned.

Changes the alarm status to next lowest severity level. For
example, a MAJOR alarm changes to a MINOR alarm. There
is no change for an element in an OK state.

Permanently removes the alarm from Operations Center.

Removes ownership from the alarm.

Enterprise Manager
(PEM)

IBM Micromuse
Netcool

Operations Center
Event Manager

BMC PATROL
Enterprise Manager
(PEM)

Operations Center
Event Manager

BMC PATROL
Enterprise Manager
(PEM)

Computer Associates
Spectrum

HP OpenView
Network Node
Manager

IBM Micromuse
Netcool

Operations Center
Event Manager

Tivoli NetView

BMC PATROL
NetlQ AppManager

Tivoli Enterprise
Console (T/EC) and T/
EC+

BMC PATROL
Enterprise Manager
(PEM)

HP OpenView
Network Node
Manager

Tivoli NetView
BMC PATROL

HP OpenView
Operations for UNIX
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Option Description Adapters

Escalate Forwards the alarm to the ITO escalation server. ¢ HP OpenView
Operations for UNIX

Group Assign Assigns the alarm to the Public or System group. + IBM Micromuse

Increase Severity Changes the alarm status to the next highest severity level.

For example, a MAJOR alarm changes to a CRITICAL alarm.

There is no change for an in CRITICAL condition.

Journal Provides a field for entering information about the alarm.
Document actions and read through previous actions. To
view the journal, open the alarm Journal property page.

Own Claims ownership of the alarm.
Print Prints all alarms in the Alarms view.
Prioritize Clears the alarm or changes its severity.

Netcool

HP OpenView
Network Node
Manager

Tivoli NetView

IBM Micromuse
Netcool

HP OpenView
Operations for UNIX

BMC PATROL

BMC PATROL
Enterprise Manager
(PEM)

Computer Associates
Spectrum

Computer Associates
Unicenter NSM

HP OpenView
Network Node
Manager

HP OpenView
Operations for UNIX

IBM Micromuse
Netcool

Operations Center
Event Manager

NetlQ AppManager

Tivoli Enterprise
Console (T/EC) and T/
EC+

Tivoli NetView

IBM Micromuse
Netcool
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Option

Description Adapters

Properties

Show Annotation

Start Automatic
Action

Start Operator
Action

Supervisor

Opens the alarm property pages. ¢ BMC PATROL

+ BMC PATROL
Enterprise Manager
(PEM)

+ Computer Associates
Spectrum

+ Computer Associates
Unicenter NSM

+ HP OpenView
Network Node
Manager

+ HP OpenView
Operations for UNIX

+ |IBM Micromuse
Netcool

¢ Operations Center
Event Manager

* NetlQ AppManager

+ Tivoli Enterprise
Console (T/EC) and T/
EC+

+ Tivoli NetView

Displays text added using the Add Annotation option. ¢ HP OpenView
Operations for UNIX

Starts an action if an automatic action was configured for an ¢ HP OpenView

alarm. Operations for UNIX

Initiates an action to resolve an event that triggered an alarm. ¢+ HP OpenView

The Start Operator Action option displays in the menu only Operations for UNIX

after configuring an operatorinitiated action for the alarm.

Provides a submenu of options for users with Supervisor ¢ BMC PATROL

privileges: Enterprise Manager
(PEM)

+ Acknowledge: Indicates that the alarm has been
reviewed. For more information, see Section 6.7.4,
“Acknowledging Alarms,” on page 86.

¢ Close: Changes the alarm status from Open or
Acknowledged to Close, then removes it from the
Alarms view.

+ DeAcknowledge: Reverses the Acknowledge option.

+ Deassign: Removes alarm assignment from the user
selected by the Assign or Accept Responsibility option.
Leaves the alarm status Open. The alarm can be
reassigned.
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Option

Description

Adapters

Suppress

Take Ownership

Unacknowledge

Changes the alarm status to Suppressed and does not use
the alarm severity to populate elements higher in the
hierarchy. Often used by administrators who need additional
time to troubleshoot issues related to an alarm.

Alarms stay Suppressed until (a) the operator closes the
alarm, (b) the alarm severity changes to OK, (c) the timer
expires (see the Operations Center 5.0 Adapter and
Integration Guide), or (d) the operator unsuppresses the
alarm with the Unsuppress Alarm right-click menu option.

Assigns responsibility for the alarm to you. For more
information, see Section 6.7.5, “Assigning Alarms,” on
page 86.

Reverses the Acknowledge option.

+ Tivoli Enterprise
Console (T/EC) and T/
EC+

+ |IBM Micromuse
Netcool

¢ HP OpenView
Network Node
Manager

+ Tivoli NetView
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Documentation Updates

This section contains information on documentation content changes that were made in the User
Guide after the initial release of Operations Center 5.0. The changes are listed according to the date
they were published.

If you need to know where a copy of the PDF documentation you are using is the most recent, the
PDF document includes a publication date on the title page.

¢ Section C.1, “November 2013 Patch Release,” on page 133

¢ Section C.2, “September 2013 Patch Release,” on page 133

¢ Section C.3, “April 2013 Patch Release,” on page 134

¢ Section C.4, “December 2012 Patch Release,” on page 134

¢ Section C.5, “June 2012 Patch Release,” on page 134

¢ Section C.6, “September 2011 Patch Release,” on page 135

November 2013 Patch Release

The following updates were made in the patch release:

Location Update

Section 7.4, “Viewing and Editing Chart Properties,” on Y-axis values are now included and considered when
page 107 chart settings are saved to defaults.

September 2013 Patch Release

The following updates were made in the patch release:

Location Update

Section 6.5.2, “Creating an Alarm Filter,” on page 74  Us the iswithin the last operator when defining
alarm filters to filter alarms for the specified aligned
interval which is inclusive to the current time interval.
For example, to match dates that are within the current
month and previous month, select is within the last 2
months.
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C.3

C4

Cb5

April 2013 Patch Release

Global updates were made to installation and file path references for Operations Center and

Operations Center features, as follows:

¢ Operations Center: The location of the main Operations Center installation is shown as

OperationsCenter_install_path

¢ Operations Center Dashboard: The location of the Dashboard is shown as
OperationsCenter_Dashboard_install_path

¢ Operations Center Configuration Management System (CMS): The location of the CMS is
shown as OperationsCenter_CMS_install_path

¢ Operations Center Experience Manager: The location of the Experience Manager is shown as
OperationsCenter_ExperienceManager_install_path

In addition, updates were made to the following sections:

Location

Update

Section 7.2, “Understanding the Chart Types,” on
page 98 and Section 7.3.1, “Creating Charts,” on
page 102

When charting SLA metrics, it can take up to several
minutes before a refreshed or new chart registers an
update, if the server has not yet recorded update data
for Availability and Outage Count properties.

December 2012 Patch Release

The following updates were made in the patch release:

Location

Update

Section 2.1.5, “Portal View,” on page 20

Section 6.5.2, “Creating an Alarm Filter,” on page 74

Added reference links to various topics mentioned.

Alarm filter names must be no longer than 50
characters.

June 2012 Patch Release

The following updates were made in the patch release:

Location

Update

Section 6.5.2, “Creating an Alarm Filter,” on page 74

New comparison operators have been added to the
Alarm Filter configurations for Date/time type alarm
columns.
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C.6

September 2011 Patch Release

The Console Guide has been renamed to the User Guide. Configuration topics that require
Administrator access privileges have been moved to “Customizing the Implementation” in the
Operations Center 5.0 Server Configuration Guide.

The following topics were migrated from the Monitoring Guide:

Location Update

Chapter 4, “Monitoring Elements and Element State,” These topics were previously contained in the
on page 43 Monitoring Guide.

Chapter 6, “Filtering and Managing Alarms,” on
page 67

Appendix B, “Element and Alarm Options,” on
page 123

The following updates were made in the patch release:

Location Update

Section 6.5.2, “Creating an Alarm Filter,” on page 74  New comparison operators have been added to the

Alarm Filter configurations for Text, Numeric and Date

type alarm columns.

Documentation Updates
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